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Disclaimer 
Dieter Spielberg DMS GmbH makes no representation or warranties with 
respect to the contents or use of this help file and specifically disclaims any 
express or implied warranties of merchantability or fitness for any particular 
purpose. Further, Dieter Spielberg DMS GmbH reserves the right to revise 
this help file and to make changes to its content, at any time, without 
obligation to notify any person or entity of such revisions or changes. 

Further, Dieter Spielberg DMS GmbH makes no representations or 
warranties with respect to any ScanFile SBE software, and specifically 
disclaims any express or implied warranties of merchantability or fitness for 
any particular purpose. Further, Dieter Spielberg DMS GmbH reserves the 
right to make changes to any or all parts of ScanFile SBE software, at any 
time, without obligation to notify any person or entity of such changes. 

Copyright 
© 1999 - 2006 Dieter Spielberg DMS GmbH, All Rights Reserved 

No part of this document may be reproduced, transmitted or stored in any 
form or by any means, electronic or mechanical, for any purpose, without the 
express written permission of Dieter Spielberg DMS GmbH. 
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ScanFile SBE Software License 
Agreement 

IMPORTANT:  Read this agreement before continuing with this installation. 
By pressing the 'Yes, I accept the agreement' button, you are deemed to 
agree to be bound by this agreement. 

This license agreement is a legal document between you and Dieter 
Spielberg Document Management Systems GmbH. By pressing the 'Yes, I 
accept the agreement' button, you are deemed to agree to be bound by the 
terms of this agreement. If you do not agree to the terms of this agreement 
press the 'No, I don't want to continue' button and promptly return the 
software CD and  accompanying documentation (the "Documentation") and 
other items to the place from where you obtained them for a refund before 
they are marked or damaged in any way. 

In consideration of the right to use the Software you agree to abide by the 
terms and conditions of this agreement. 

1. GRANT OF LICENSE. 
The Software consists of the software modules by: 

a) Dieter Spielberg Document Management Systems GmbH, a German 
public listed company having its place of business at Wanheimer Str.593, 
47249 Duisburg , Germany ("Spielberg"). 

b) Microsoft Corp., a Washington Corporation having its place of business at 
1 Microsoft Way, Redmond, WA 98052-6399, USA ("Microsoft"). 

c) Wise Solutions Inc., a Michigan Corporation having its place of business at 
2200 N. Canton Centre Road,  Suite 150, Canton, MI 48187, USA ("Wise"). 

d) Apex Software Corporation, a Pennsylvania Corporation having its place 
of business at 4516 Henry Street, Pittsburg, PA 15213, USA ("Apex"). 

e) Stellent Inc., an Illinois Corporation having its place of business at 330 N. 
Wabash Ave., 15th  Floor, Chicago, IL 60611 ("Stellent"); 

f) Progress Software Corporation, Crescent Div., a Massachusetts 
Corporation having its place of business at 14 Oak Park, Bedford, MA 11730 
("Crescent") 
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g) Nuance, a belgian Company having its place of business at 
Guldensporenpark 32, 9820 Merelbeke ("Nuance"); 

h) Innovasys Ltd., an english Company having its place of business at 
Westowe, Chelston Road, Torquay, Devon, UK, TQ2 6PU ("Innovasys") 

You understand and acknowledge that any software module included in the 
Software may have utility with or be able to be called by other software 
and/or hardware, which Spielberg considers to be an unauthorised use of the 
Software. Accordingly, you agree that you will use such software modules 
only as part of the Software and not in conjunction with, or as part of, or as a 
component of other software and/or hardware which makes calls to such 
software modules. 

Spielberg grants you the personal non-exclusive rights for a single-user 
version of the Software, to install and use the Software for internal purposes 
only on a single computer (the Software is considered in use when it is 
installed in the temporary memory, i.e. RAM, or the permanent memory, i.e. 
Hard Disk Drive). 

2. BACKUP COPY. 
a) You may make whatever copies you deem appropriate from the ScanFile 
SBE "delivery" Compact Disc, the Programs, Example Files and any other 
promotional material that may be included thereon. The Application Manual, 
or any part thereof, may be reproduced in sufficient quantity to support only 
the number of users licensed to you and no more. You must reproduce and 
include on the backup copy the copyright notice and other ownership or 
proprietary legends that are on the original copy of the Software. 

b) You may NOT make any copy whatsoever of the License. ANY ATTEMPT 
TO COPY MAY CORRUPT THE ENABLING LICENSE. The License 
represents the full purchase value of the license to use the ScanFile SBE 
Software.  

3. RESTRICTIONS. 
a) You may not market, distribute or transfer the Software or the 
Documentation to others, or electronically transfer the Software from one 
computer to another over a network except as expressly provided herein. 

b) You may not de-compile, reverse engineer, disassemble or otherwise 
reduce the code of the Software to a human perceivable form. 

c) You may not modify, adapt, translate, rent, lease or loan the Software or 
the Documentation or create derivative works based on the Software or the 
Documentation. 

Page II 



ScanFile SBE User Guide 
ScanFile SBE Software License Agreement 

4. OWNERSHIP AND COPYRIGHT. 
Spielberg, Microsoft, Wise, Apex, Nuance, Stellent and Crescent  reserve all 
rights to their respective software modules of the Software and the 
Documentation. The Software and the Documentation is copyrighted. 
Unauthorised copying of the Software, including portions thereof, or the 
Documentation is expressly forbidden. 

5. EXPORT CONTROL. 
You agree that the Software and Documentation will not be shipped, 
transferred or exported into any country or used in any manner prohibited by 
the United States Export Administration Act or any other applicable export 
control laws, restrictions or regulations of the countries involved. 

6. SUPPORT AND UPDATE. 
a) Spielberg, Spielberg's subsidiaries or affiliates, their distributors and 
dealers are not responsible for maintaining or helping you to use the 
Software and the Documentation, excepting where agreements have been 
entered into between specific parties, i.e. Spielberg:Distributor, 
Distributor:Dealer, Dealer:End User. 

b) No updates, fixes or support will be made available for the Software and 
Documentation other than by publishing such revisions on the Spielberg web 
site: http://www.spielberg.de or http://www.spielbergsoloutions.com 

c) Any updates, fixes or support will be made available on the said web site 
solely at the discretion of Spielberg, who are under no obligation whatsoever 
so to do. 

7. LIMITED WARRANTY AND DISCLAIMER OF 
INDEMNITY. 
Limited Warranty. The Software is provided "as is" without warranty of any 
kind, either express or implied, including, but not limited to implied warranties 
of merchantability and fitness for a particular purpose. The entire risk as to 
quality and performance of the Software is with you. Should the Software 
prove defective you (and not Spielberg, Spielberg's affiliates, their distributors 
or dealers) assume the entire cost of all necessary servicing, repair or 
correction. Some states or jurisdictions no not allow the exclusion of implied 
warranties, so the above exclusion may not apply to you. This warranty gives 
you specific legal rights and you may also have other rights which vary 
according to state or jurisdiction. 
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Spielberg, Spielberg's affiliates, their distributors and dealers do not warrant 
that the functions contained in the Software will meet your requirements or 
that the operation of  the Software will meet your requirements or that the 
operation of the Software will be uninterrupted or error free. 

However, Spielberg or Spielberg's affiliates warrants a compact disc or 
diskette on which the Software is stored to be free from defects in materials 
and workmanship under normal use for a period of ninety (90) days from the 
date you purchased the same, as evidenced by a receipt or otherwise. Some 
states or jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. 

CUSTOMER REMEDIES 

Spielberg's entire liability and your exclusive remedy shall be the 
replacement of the Compact Disc and/or Diskette not meeting the LIMITED 
WARRANTY and which is returned to Spielberg or Spielberg's marketing 
affiliate, Spielberg Soloutions Ltd., with a copy of your receipt or otherwise. 
The LIMITED WARRANTY is void if failure of the Compact Disc has resulted 
from accident, abuse or misapplication of the software. 

No liability for consequential damages. In no event shall Spielberg, or 
Spielberg's affiliates, their distributors or dealers be liable for any damages 
whatsoever (including without limitation, direct or indirect damages for 
personal injury, loss of business profits, business interruption, loss of 
business information, or other consequential or incidental damages) arising 
out of the software, the use thereof or inability to use the software even if 
Spielberg, Spielberg's affiliates, their distributors or dealers has been advised 
of the possibility of such damages. Some states or jurisdictions do not allow 
the exclusion or limitation of liability for consequential or incidental damages, 
so the above limitation may not apply to you. 

Disclaimer of indemnity. Spielberg, Spielberg's affiliates, their distributors and 
dealers shall have no obligation to indemnify you against any claim or suit 
brought to you by a third party alleging that the Software or the use thereof 
infringes any intellectual property of such third party. 

8. TERM. 
This agreement is effective upon pressing the 'Yes, I accept the agreement' 
button and remains in effect until terminated. You may terminate this 
agreement by destroying the Software and any copy thereof. This agreement 
will also terminate if you fail to comply with any of the terms of this 
agreement. In addition to Spielberg enforcing its legal rights, you must then 
promptly destroy the Software and any copy thereof. 
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9. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE. 
The Software is provided with Restricted Rights. Use, duplication or 
disclosure by the United States Government is subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of 
the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, 
as applicable. The Software is a "commercial item", as that term is defined at 
48 C.F.R. 2.101 (Oct 1995), consisting of "commercial computer software" 
and "commercial computer software documentation", as such terms are used 
in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 C.F.R. 12.212 and 48 
C.F.R. 227.7202-1 through to 227.7202-4 (June 1995), all U.S. 
Governmental End Users acquire the Software and the Documentation with 
only those rights set forth herein. Manufacturer is Dieter Spielberg, 
Wanheimer Str. 593, 47249 Duisburg, Germany. 

10. ACKNOWLEDGEMENT. 
By  selecting the 'Yes, I accept the agreement' option, you acknowledge that 
you have read this agreement, understand it and agree to be bound by its 
terms and conditions. You further agree that this agreement is the complete 
and exclusive statement of agreement between you and Spielberg 
concerning the subject matter hereof, which supersedes any proposals or 
prior agreements, oral or written, and any other communication between you 
and Spielberg relating to the subject matter hereof. No amendment to this 
agreement shall be effective unless signed by a duly authorised 
representative of Spielberg. 

Should you have any questions concerning this agreement, or if you desire to 
contact Spielberg for any reason, please write to your authorised supplier 
requesting that they pass your correspondence to Dieter Spielberg Document 
Management Systems GmbH or  Spielberg Soloutions Ltd.. 
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Introduction 
Thank you for purchasing ScanFile SBE, the fast, secure and user-friendly 
solution to your document management requirements. ScanFile SBE offers a 
stable and flexible platform for the storage, referencing and retrieval of your 
organisations documents. ScanFile SBE supports a vast range of black and 
white and colour document scanners, and includes several options to make 
the storage of electronic format documents, such as word processing and 
spreadsheet format files a straightforward task, including integration with 
Microsoft Office. 

What is ScanFile SBE? 
ScanFile SBE is the Small Business Edition of the Document Management 
System ScanFile. ScanFile SBE is a full 32bit application that is optimised to 
run on Microsoft Windows NT4, 2000 and XP Professional based 
workstations. ScanFile SBE can also be installed on Microsoft Windows 
NT4/2000/XP. 
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Important – Please Read 
Once ScanFile SBE has been installed, it can be started, and will 
immediately inform you that it is not licensed, and will then open the licensing 
window. 

ScanFile SBE Features 
ScanFile SBE is a very straightforward and easy document management 
system to use and manage, but has all the features required for serious 
document management applications. 

• Intuitive user interface 
• Black & white and colour scanner support 
• Import any electronic format document such as MS Word/Excel files 
• Comprehensive document referencing and retrieval features with user-

defined index fields, keywords and full text search. 
• Full document display features including zoom, rotate and enhance. View 

multiple documents 
• Inbuilt document viewer that supports over 200 document types including 

MS Office and PDF documents 
• TIFFWriter 
• Full text OCR 
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Operating Systems 
ScanFile SBE is designed to run on the following operating systems: 

• Microsoft Windows ME 
• Microsoft Windows NT4 Workstation 
• Microsoft Windows 2000 Professional 
• Microsoft Windows XP Professional 
 
Service Packs 

Please ensure that you keep your operating system up to date with the latest 
service packs. 

ScanFile SBE Requirements 
ScanFile SBE is a 32 bit application designed to require only the least 
amount of resources on server and workstations. The nature of the 
application requires additional storage space to store your documents. In 
addition the specification of a ScanFile SBE workstation has to meet the 
requirements of every day use, attached scanners, type of scanning you are 
performing and the type of documents you work with. 

Hard Disk Space 
A full installation of ScanFile SBE will require around 100 Megabytes of hard 
disk space. Additional to the storage space that is needed for the application 
itself, sufficient storage space is needed for your documents. Please ensure 
that you have the correct amount and type of storage for your documents. 
The storage used may be a mix of hard disk space and CD’s, DVD’s and 
optical disk, either using single drives or jukeboxes. 

The amount of storage you might need is the result of a combination of 
factors, such as 

• Are the documents completed or are they still being updated? 
• How many existing documents? 
• What is the average document size on disk? 
• How many documents are created within a period? 
• At what document age does the retrieval rate decrease? 
• Is there a retrieval time requirement? 
• How many retrievals are required per hour/day? 
• How many different applications does a customer have? 
• What index information is used? 
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Taking these factors into account you can approximate the amount of storage 
space for a given period and put in place your on-line and off-line storage. 

You need to ensure that whatever method of storage is used, adequate and 
regular backups are taken.  

RAM 
Typically, the ScanFile SBE program itself requires between 30 and 60 
Megabytes of RAM to run. This is dependant upon what operations are being 
performed within ScanFile SBE. When viewing a document, the amount of 
memory used will increase by the requirements of the document and can 
differ greatly. 

When viewing a scanned or imported image, the compressed file is read from 
disk and then uncompressed into the workstations memory. For a black & 
white A4 document scanned at 300dpi, the uncompressed size will be about 
1 Megabyte. For a 24bit colour A3 document, scanned at 400dpi, the 
uncompressed size will be just under 100 Megabytes. 

Electronic format documents, such as MS Word or Excel are displayed with a 
multi functional viewer within ScanFile SBE and the memory that is required 
is depend on file type and size. 

The specification for a scanning workstation will be broadly similar to that 
required for viewing the documents scanned. The way a scanner works must 
be taken into account as they do vary in the way images are presented to the 
workstation. 

As an example, The Canon DR-3020 scans A4 black & white documents at a 
maximum resolution of 300dpi. The DR-3020 has inbuilt image compression, 
and will therefore typically send over 35-50k of information to the workstation 
for each page scanned. The DR-5080c however, can scan 24bit colour 
documents up to a maximum of A3 at 400dpi. As the DR-5080c has no 
onboard compression, this can mean that up to 98MB of information can be 
sent from the scanner to the workstation for each A3 colour page scanned. 
This must then be compressed and saved to disk. The size of the saved 
image can range from 2k to 100Mb, depending upon the type of image, and 
the compression levels that are used. 

When calculating the amount of memory a workstation should have, the 
requirements of the operating system need to be taken into account. 
Additionally, the amount of memory used by other applications that are 
operating simultaneously need to be considered. 
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If there is insufficient RAM in the workstation, the operating system will use 
the hard disk as virtual memory. This will dramatically affect the 
performance of the workstation. 

Minimum Requirements 
The following workstation specification is recommended as a minimum 
requirement 

• PC using a 2GHz Pentium 4 Processor 
• 256 MB RAM 
• 17‘‘ Display 
• CD-ROM Drive 
• 100 MB Hard Disk Drive (without Data) 
• MS Windows 2000 Professional 

Dongle 
ScanFile SBE products are protected from illegal use by utilising a hardware 
dongle. The dongle can be supplied as a USB device or one that attaches to 
the workstation parallel printer port. The parallel port must be set to ECP. 
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Overview 
ScanFile SBE can be installed as a standalone system on a workstation. 
Please read the installation instructions carefully before installing to ensure 
that you fully understand what will be installed, and what needs to be 
prepared prior to installation. 

The installation procedure will be dependent upon which operating system 
ScanFile SBE is to be installed. ScanFile SBE can be used with Windows 
ME/NT4/200/XP as operation system. 

Standalone Installation 
To install ScanFile SBE, select Run from the Start Menu and then choose 
SetupSF.exe from the Software directory on the ScanFile SBE CD. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile SBE will be installed into. A default of 
C:\Programs\ScanFile SBE will be offered and this should normally be 
accepted. 

The Destination directory selection dialogue will also display the available 
disk space on the chosen drive, as well as the space available after ScanFile 
SBE has been installed. Once you have chosen the drive and directory, 
press the Next button. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile SBE installation process will replace. These can be older 
versions of ScanFile SBE components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 

Please note that the ScanFile SBE Installation process will only replace 
older versions of common Windows components. 

Page 16 • Installing ScanFile SBE 



ScanFile SBE User Guide 
Standalone Installation 

Components 
The next step is to choose the ScanFile SBE components to be installed. The 
core ScanFile SBE program will be installed automatically, but you must 
select the additional options individually. Please note that if you have not 
purchased the TIFFWriter or OCR, these will not function. 

 

Option/Module Description 

MS-Office Integration This option will add Send to ScanFile SBE and 
Print and Send to ScanFile SBE options into 
Microsoft Office 2000 or XP. The Version Microsoft 
Office 97 only supports Word and Excel. 

To use the Microsoft Office Integration a Version of 
Microsoft Office must be installed. 

ScanFile SBE 
TIFFWriter 

This option installs a special printer driver, which 
allows you to print documents from any windows 
application as TIFF G4 or JPEG files directly into a 
selected ScanFile SBE folder. 

ScanFile SBE OCR This option offers the OCR Full Text Reading 
function. The Full Text OCR can be performed 
allowing you to search the documents for specific 
text. 

ASPI Layer This option will install the latest release of Adaptec's 
ASPI drivers for their range of SCSI cards. This will 
be required if you intend to perform scanning on the 
workstation using a scanner attached to a SCSI 
card. 

 

If TIFFWriter was selected to be installed, and the operating system on the 
PC is Microsoft Windows NT4, you will be asked to insert the NT4 CD. 
ScanFile SBE needs to install files that are on the NT4 disc. 

Licensing 
Once the ScanFile SBE installation is complete, the dongle can be attached 
to the workstation, and then licensed. Please see the Licensing chapter for 
instructions on how to do this. 
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Summary 

Installation Type 
Standalone   SetupSF.exe 

Install Location 
Standalone Installation  C:\Programs\ScanFile SBE 

Backup Location 
For installation rollback 

Components 
Office Integration   MS Office 97, 2000, XP & 2003 
TIFFWriter   Print to ScanFile SBE Folder 
OCR    Zone, Full Text & Forms Recognition 
ASPI Layer   For Adaptec SCSI cards 

Personal Hitlist 
Private document store for each user. Used for sending documents to users, 
and by the Document Routing option. 

Removing ScanFile SBE 
Always use Control Panel –> Add/Remove Programs 
 
Removing ScanFile SBE does not delete data. 
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Introduction 
ScanFile SBE uses a software activation which is stored on the PC where 
ScanFile SBE is installed. The customer receives a unique serial number, 
which must be used to activate their  system. This is done via the internet 
and there are two ways of doing this. It can be either a direct download from 
the internet, if the  ScanFile SBE workstation is connected to the internet. 
The other possibility is realised by a file upload/download, which can be 
performed on any PC connected to the internet. 

Direct activation via Internet 
Start ScanFile SBE. If the software is not activated, a message comes up. 
Click the menu Help –> Licensing. The following window appears: 

 

Enter your serial number and address information. 

If your ScanFile SBE workstation is connected to the internet, first click on 
the button on the bottom left of that window, if not already active. Afterwards 
click on Activate. The system will connect to the ScanFile SBE licensing 
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server and will be activated automatically. The top label of this window will 
show: This software is activated. 

If you click on the Activation server URL button the internet address for file 
upload/download connection is displayed. 

 

Activation by file upload/download 
If your ScanFile SBE workstation is not connected to the internet, you can 
create a file which has to be sent to the activation server. In return an 
activation file can be downloaded from the activation server. If this file is 
uploaded on the ScanFile SBE workstation, the system is activated. If you 
have no internet connection at all, send this file to your supplier, who can 
return the activation file to you. 

• Click to the button with the disk/key symbol on the bottom left. Now the 
activation is set to file upload/download. Now click to Save to file. Store 
this file in any location. This file has a suffix named .DSR 

• This file must be used and uploaded when connecting to the ScanFile 
SBE activation server. Open your internet browser and go to the following 
page: 
www.spielberg.de/sbe-activation 
Specify the stored DSR file for upload and click to OK. 

• You will receive a file with suffix DSA which must be stored by clicking to 
OK. 

• Transfer this DSA file to the ScanFile SBE workstation to be activated. 
• Click on Help –> Licensing and then to button Load from file and select 

the DSA file. 
 
The top label of the licensing window should display now: The system is 
activated. 
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Overview 
This section describes the first steps after the installation of ScanFile SBE. It 
leads your through the first start-up of ScanFile SBE, the licensing process 
and informs you about important general settings. 

ScanFile SBE Main Screen 
After logging in successfully, the main window will be displayed. If you 
haven’t licensed ScanFile SBE yet, the License Manager will open 
automatically. Please see the Licensing chapteron how to activate your 
ScanFile SBE dongle 

 

This window will have a standard Windows Menu bar and Toolbars for quick 
access to the applications functions. 

When running ScanFile SBE for the first time, default settings should be 
applied to enable the application to know what input device to use, and 
where you want to store the documents. A short description how to apply 
these settings follows.  
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Search Drives 
Before folders and libraries can be created, search drives for ScanFile SBE 
to work on have to be defined. Selecting Choose search drives from the 
File menu allows you to specify the locations which can be anywhere on the 
workstation, mapped drives or UNC paths. Within the Search Drives window, 
a list of drives and paths that have been added will be displayed. When 
ScanFile SBE is first started, the Search Drives selection screen will be 
automatically displayed, and will list the available drives on the workstation. 

The list of search drives is stored centrally and shared with all workstations. If 
a user does not have rights to access certain paths defined, then those paths 
will appear empty. 

To add a storage location to the list, press the + button on the top right of the 
display. A window will then be displayed where you can select the drive or 
UNC path that you want to add. To remove a storage location, highlight it on 
the list and press the – button on the top left of the display. 

Scanner Selection & Setup 
Before any scanning can be done, the scanner must be selected. Select 
Choose Scanner from the File Menu, and select the appropriate scanner. 
Then select Scanner Settings from the Options menu to apply default 
settings for the selected scanner. These can be for scan resolution, paper 
size, single/double-sided scanning, brightness, contrast etc.  

A full description of the options for all scanners is given in the Scanner 
Setup chapter. 

The scanner settings are saved for every single user and folder. Please 
note: by selecting Options -> Scanner Settings the settings for the opened 
folder are changed. If no folder is open, the scanner settings are saved as a 
default for the logged in user. This default will be copied into every new 
folder that is created by the logged in user. 

Next Steps 
Before you can store any documents to ScanFile SBE you must first create 
ScanFile SBE folders to store the documents in your selected locations. 
Creating folders is fully described in the Folders chapter. Once you have 
created a folder and stored your documents the searching and viewing 
options are described in the chapter named Searching & Viewing. 
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Please also read the General Settings chapter, as this describes the options 
available that will affect how the ScanFile SBE main screen, ScanFile SBE 
folders and libraries will be displayed as well as affecting the actions of 
keyword searches and the display of hit lists. Many other settings influencing 
the behaviour of ScanFile SBE are described in that chapter, too. 

It is very important that you read and understand the General Settings 
chapter to ensure that you get the best from your ScanFile SBE solution. 
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Overview 
All documents either scanned or imported into ScanFile SBE will be held in 
ScanFile SBE Folders. Folders not only hold the images, but also the 
indexing information and annotations associated with the images. If using the 
optional OCR module, the OCR full text tables are also held in the folder. 

Folders can be created on any rewriteable media available to the PC as a 
drive reference. This includes network drives. It is always a good idea to 
have separate drives for storing folders and for programs. When creating a 
folder, you can give it a name of up to 32 characters, and specify up to ten 
fields with a maximum length of 255 characters per field. Field functions can 
be applied to these fields providing rapid automatic indexing during scanning 
or post-indexing. 

Create Folder 
To create a folder, select Setup Folders from the File menu, and the Folder 
configuration will be displayed. 

 

From the Setup folders screen, a folder can be created or modified. First of 
all, you must choose which drive or UNC path the folder is to be created in, 
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and you can then give the folder a name. You can also specify a capacity for 
the folder. In this example, it has been set for 600Mb for a CD. 

Once this has been reached, no further scanning into the folder will be 
allowed, and you will be prompted to archive the folder to CD’s or DVD. A 
user-defined capacity can be defined in megabytes, as well as options for 
various other media types. An unlimited option is also available for network 
Drive or RAID arrays. 

The fields for the folder can then be defined. A folder can have up to 10 
fields, with a maximum length of 255 characters, and Field properties and 
Extended Field properties can be applied to them. The field names, lengths 
and functions can be modified at any time without any loss of existing data. 

Field Properties 
Each field can be set with a property value, depending upon the entry 
requirements for that field. The available properties are listed below. 

None 
No auto indexing or field formatting property has been applied. 

Duplicating 
An entry typed into the field will be kept and passed on to all subsequent 
records created until the entry is amended. 

Counting 
The field content is automatically incremented by one (digit or character). The 
“ “ option will left fill the field with blanks, the “0” will left fill with 0’s. 

Date 
The system date will be entered into the field automatically. Please note that 
the date format will be taken from the operating system Short Date Format. 
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Long Date 
The system date will be entered into the field automatically. This is taken 
from the system Long Date Format. 

Checksums 
These options will check entries for errors via the use of check digits included 
in the value being entered. 

Thesaurus 
A predefined list of words and their associated synonyms can be applied to a 
field. If the synonym is typed in when indexing, the word will be shown. 

Extended Field Properties 
Extended properties can also be applied to each field, which can dictate what 
is allowed to be entered into a particular field. These properties are 
accessible by selecting the button Ext. on the extreme right of the field to 
which you wish to apply them. 
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Input Mask 
To set an input mask, type in the type of character you wish to be typed in for 
each of the field character positions in the Mask box. The character types are 
listed. As can be seen in the example above, entering dashes and slashes 
within the mask will force those characters to be in the field. When typing into 
a field, the cursor will automatically jump over these characters. You can test 
the format of the input mask within the Test field box. 

Duplicate Index Action 
The Duplicate Index Action list offers options that will determine what action 
should be taken if the same index information as an existing record is 
entered. The available options are: 

Action Description 

None Duplicate Index Action is disabled 

Append The document/pages will be appended to the existing 
record 

Append with 
prompt 

The user will be prompted whether to append the 
document/pages to an existing record. 

Reject The index information will be rejected 

Prepend The document/pages will be inserted at the beginning of 
the existing record 

Prepend with 
prompt 

The user will be prompted whether to insert the 
document/pages at the beginning of the existing record. 

Copy index This option is the same as the field property Duplicate 
Index Action. If you use the Copy Index property in the 
Extended Field Properties you are able to use another 
field property like Barcode for the index field. 

Date Validation 
Validation of a user entered date can be performed by selecting the Check if 
Valid Date option. This will ensure that incorrect dates are not accepted. In 
addition, you can set the format in which the date has to be entered by the 
user by selecting the New Date Format option, and entering the required 
format in the field provided. Some Examples: 
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Date   Format 
23.06.03  DD.MM.YY 
2003-06-23  YYYY-MM-DD 
06/23/2003  MM/DD/YYYY 

Mandatory Field 
If this option is selected, an entry must be made into the field when indexing. 

Field Must be Full 
This option, when selected, will force the user to enter index information in 
the field, to the full length of the field. For example, if the field length is set to 
10, then 10 characters must be entered by the user into the field. 

Right Align 
When entering numeric values, the contents of the field can be automatically 
right aligned with leading 0's or blanks by selecting the appropriate option. 

Advanced Settings 

Duplicate Index Action 
This option Execute after Zone OCR reading allows you to assign whether 
the duplicate index action will be executed after a zone OCR. 

Index information 
With the option Clear fields the contents in the index fields within the toolbox 
will be deleted by changing the category in the folders toolbox. 

Thesaurus 
The Thesaurus field property can be used to cut out repetitive indexing, and 
to ensure that index data such as names are typed correctly. A list of words 
can be defined, and multiple synonyms - or short codes - can be set for each 
word. For example the short code 'dsp' can be applied to 'Dieter Spielberg 
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DMS GmbH', and when indexing, if 'dsp’ is typed in, it will be replaced with ' 
Dieter Spielberg DMS GmbH '. 

 

To create or edit a Thesaurus list, from the Options menu, choose Edit 
Thesaurus. On the displayed screen, choose Thesaurus New/Open to 
open an existing Thesaurus, or to create a new one. The Thesaurus files are 
given the extension '.THE', so are easily identifiable. 

The words are displayed in the left column, with their associated synonyms in 
the right column. Only the synonyms for the selected word are displayed. 

To add a word, choose Add Word and then type the word. To add a 
synonym for a word, select the word then choose Add Synonym, and then 
type the synonym. When finished, choose Close and the changes will be 
automatically saved. 

The same Thesaurus can be applied to as many folders as you wish. They 
are not specific to a folder. 
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Thesaurus Import 
A new button was added to the Thesaurus window: Import Thesaurus. This 
function allows you to automatically fill or extend a Thesaurus file. 

After clicking on Import Thesaurus, you are asked to select a file containing 
update information. Then following window is displayed: 

 

Enter field separator, field delimiter and text mode and click on Start Import. 
The file will be imported. The first field of a line will be considered to be a 
word, all following fields will be interpreted as synonyms belonging to the 
word. 

If a word is not found in a ScanFile SBE Thesaurus, it will be created. All 
synonyms belonging to this word will be added, as long as they are not 
already in use. Synonyms have to be unique, so double entries are not 
allowed. 

After a successful import you can return to the Thesaurus window by clicking 
on Close. If you opened the Thesaurus from an open folder, the new entries 
will be immediately at your disposal. 

Keywords 
A predefined list of keywords can be created and assigned to a folder. This is 
an extra level of indexing, and allows multiple keywords to be attached to a 
particular document. To attach a keyword list to a folder, click on the 
Keyword List button in the Setup Folders dialogue, and then select the list 
you wish to apply. All keyword lists have the extension '.KEY'. 

To create a keyword list, or to edit an existing one, choose Edit keyword 
lists from the Options menu. 
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Click on the New/open list button to open or create a keyword list. To add 
words to a list, click on the Add Word button, and type in the words you wish 
to enter. 

To make words visible/invisible, click on the column headed Visible next to 
the word, and either a red cross or a green tick will be displayed. If a keyword 
is not visible it will not be displayed when the folder is opened. 

Once you have finished, click the Close button, and the changes will be 
saved. 

Working with folders 
To open a folder, go to the File menu and select Open Folder. Only one 
folder can be open at any one time. From the displayed screen, you can 
select the drive the folder is on, and then select the folder you wish to open. 
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Whenever a folder is open the folder toolbox will be available, allowing you to 
access the majority of functions that need to be carried out within a folder 
such as scanning, indexing and editing and searching. 

 

The structure of the folders toolbox depends on the folders setup and may 
vary from the picture above. 

Toolbox – Scan 
The following tools will be available if the Scan option is selected in the folder 
toolbox. These allow you to scan single or multi-page files, select manual or 
auto feed, and to browse through the current file. 
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Toolbox – Search 
This selection allows you to specify the required search criteria for 
documents, and perform a search. This will result in a list of the files found 
being displayed. 

 

Toolbox – Edit 
From this the indexing information for a document can be changed. You can 
also amend the document itself by inserting, appending, revising and deleting 
pages. 

 

Toolbox – Postindex 
Post-indexing allows you to scan documents that are to be indexed at a later 
date. The images scanned are stored in a separate area of the folder, and 
are not divided into files. When going through the post-index pool, the images 
can be separated into files by using the available tools. They can also be 
appended to existing files. 
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Keyword Display 
If a keyword list has been assigned to a folder various options as to how and 
whether the keywords are displayed are available. 

In the Keywords Search Mode of the General Settings screen, the 
keyword list preferences can be set. 

You can choose not to display the keyword list at all by selecting Hide 
Keyword list. The Display keywords as Text option will display the 
keywords in a column format, but if this is not selected, the keywords will be 
displayed in a cell format. 

You can also choose whether, when doing a multiple keyword search, the 
records displayed will show records that have keyword 1 AND keyword 2, or 
that have keyword 1 OR keyword 2. 

To select multiple keywords when either indexing or searching, hold down 
the CTRL key when clicking on the words you wish to select. 
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Folders Summary 
Folders are the storage location for all documents held in a ScanFile SBE 
system. Folder can also contain the index data associated with those 
documents. 

Folder Specification 
Folder Name   32 Characters 
Fields    10 Maximum 
Field Name   32 Characters 
Field Length   255 Characters Maximum 
Keyword List   1 per Folder 
Thesaurus   1 per Field 

Extended Settings 
Compression Format  TIFF/JPeg or LuraDocument 
Duplicate Index Action  Sets the action for duplicate index information 
Clear Fields  Clears the index information within the folders 

Toolbox when changing the category 

Field Properties 
None    No Property 
Duplicating   Field retains previously entered value 
Counting " "   Puts leading blanks in front of numeric values 
Counting "0"   Puts leading 0's in front of numeric values 
Date    Current Date 
Long Date    Current date in format eg. '07 October  2003' 
Thesaurus   Assign Thesaurus to field 
Copy Index  Duplicates index information of existing 

records 
Mod 2    Customer checksum 
Mod 10.1    Customer checksum 
Mod 11.1    Customer checksum 
Mod 11.2    Customer checksum 
Verify 11    Customer checksum 
ISBN    Customer checksum 
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Extended Properties 
Mask    Only accept input in pre-defined format 
Duplicate Index   Allow/Not allow Duplicate index 
Check Valid Date  Checks entry for valid date & specified format 
Mandatory Field   Field must contain data 
Must be Full  Field must contain data to maximum field 

length 
Right Align 0's   Sets leading 0's in front of numeric values 
Right Align " "'s   Sets leading blanks in front of numeric values 
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Editing Documents 
There are several options that allow you to change a document after it has 
been scanned. These are: 

• Append Pages 
• Insert Pages 
• Delete Pages 
• Revise Pages 
• Split File 
• Change the Page Order 
• Save Rotation 
 
The first four options are available in the Folder Toolbox from the Edit option. 

Append Pages 
Once you have selected the file you want to append to on the Hitlist, choose 
the Edit option in the Folder Toolbox, and press the append icon. The pages 
to be appended will then be scanned. After all the pages have been scanned, 
you will be prompted to save the pages, continue scanning, or to abandon 
the append 

Inserting Pages 
To insert pages into an existing file, select the file on the Hitlist, then go to the 
page that you want to insert pages before. Click on the Insert pages icon in 
the Edit option of the Folder Toolbox. Once the feeder is empty, you will be 
prompted to save or discard the pages just scanned. 

Delete Pages 
There are several choices when deleting pages from a document. First of all, 
display the page at which you wish to start deleting, and then select the 
Delete icon from the Folders Toolbox. You will then be prompted on what 
you want to delete. Select the appropriate option and the file will be updated. 
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Revise Pages 
An original document can be revised by clicking on the Revise Pages button 
in the Folder toolbox Edit menu. This will scan in an amended copy of the 
document and allow you to browse through the revised and original pages. 

Split File 
This option enables you to break apart a single file in to two files with 
identical index information. To do this, select the file you wish to break apart 
from the Hitlist, and then display the page of the file that you wish to become 
the first page of the second file. Select Split File from the Edit menu. After 
confirming that you wish to proceed, a second file will be created. If required, 
you can then edit the index information of the files to reflect the changes. 

Change Page Order 
Once a document has been scanned, you may find that you wish to change 
the position of a page within the file. This can be achieved in one of two 
ways. 

Image Display Menu 

While displaying the page of the file that you wish to move, pressing the right 
mouse button in the image display window will show the right click menu. 

By choosing Change Image Position you will then be prompted to enter the 
number of the page you wish to move the currently displayed page to. 
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FastPics Drag & Drop 

Within the FastPics window, by holding down the left mouse button on the 
page of the document you wish to move, and then dragging that page to the 
position within the file you wish to move the page to, the page will be moved 
and the file reordered. 

Save Rotation 
The orientation that a scanned image will be displayed can be set and saved 
so that it will always be displayed in the chosen orientation.  

To do this, set the currently displayed image to the rotation you wish to save 
and from the View menu, select Save rotation for. You can then choose to 
set the rotation for the displayed page, all pages of the record, or all selected 
records. 

The image rotation setting is saved in the Folder database, and does not 
affect the original scanned image. 

Annotations 
These can be used to mark or highlight part of a page that is of particular 
interest. The annotations are specific to the page on which they are created. 
Different annotations can be added to different pages within the same 
document. The annotation types are: 

• Text annotation 
• Line 
• Highlight 
• White-out Area 
• Black-Out Area 
 
If a file has annotations attached to pages, this will be signified by a pencil 
symbol in the top-left corner of the image display window. This will also be 
shown in the FastPics. 
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Please note: Annotations cannot be applied to native format documents. 
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Overview 
New documents can be scanned into ScanFile SBE via either the Scan 
mode of the folder toolbox, or by the Post-index mode. 

How the indexing information relating to the document will be entered is very 
much dependent upon the type of document being scanned, and how the 
folder was set up, and what properties have been set for the folder fields. The 
most basic method is to enter the indexing information into the fields in the 
folder toolbox, select the keywords required (if applicable) and then start 
scanning. If the documents have barcodes, if a field has been set for auto 
increment, or if the documents are to be OCR'd, the index information will be 
created automatically after the document has been scanned. 

Single & Batch Scan 
To add documents to your folder by scanning, choose the Scan option from 
the folder toolbox, select either the Batch Scan or the Single Page Scan 
button to start scanning. 

Batch Scan will create will create a multi-page document from the pages 
being fed through the scanner. Once the feeder is empty, you will be 
prompted to save the images or to continue scanning into the same file. 
Single Page Scan will create a new file for each page scanned. 

In both modes the Canon DR-3020, DR-5020 and DR5080c can recognise 
and act upon control sheets, allowing you to change between single & double 
sided scanning, text & photo mode, and also for file separation whilst using 
batch scan. The Job Separation Sheets in ScanFile SBE allow the automatic 
file separation independently from the scanner model. This option needs the 
license for Forms Recognition. 

For scanners directly controlled from ScanFile SBE, scanning can be 
stopped at any time by pressing the STOP button, which will appear in place 
of the Scan icons, while scanning is in progress. 

If you wish to change any of the default parameters for the scanner prior to 
starting to scan, this must be done from the Scanner Setup screen. 

Postindex Pool  
The Post-index facility lets you scan batches of documents very quickly, and 
then divide them into files and apply indexing information to them at a later 
date. Documents scanned to this 'Pool' are kept in a special work area until 
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they are indexed, whereupon they are added to the main index and file 
storage location within the folder. 

To add documents to the Postindex pool, select Post-index from the Folder 
Toolbox, place pages into the scanner feeder, and then select the Scan 
Pages icon. 

Once the documents are in the pool, they can be viewed by using the Next 
page & Previous page icons. 

To create a new file, select the page that is the first page of the file, type in 
the indexing information for the file, and then click on the Save Image icon. 
Once you have pressed the Save Image icon, the next page in the Postindex 
pool will be displayed.  

To keep adding pages to the new file, just keep on pressing the Append 
page icon for each page of the file that is displayed. When a new file needs 
to be created, just press the Save Image icon again. 

The Append page feature of Postindex can also be used to append pages to 
existing files. Via the search option find the file you wish to append to, go to 
the Postindex pool, display the page you want to append, and then press the 
Append page icon. 

Instead of pressing the Append icon you can also press the + key on the 
keyboard to append pages. This will only work if the first field is in overwrite 
mode. Pressing the - key will bring the appended page back into the 
Postindex pool. Pressing CTRL and + will append all remaining images 
from the Post-Index pool. By pressing ALT and + all remaining pages will 
be imported into the folder as single page documents. 

Function Sheets 
The Canon DR-3020 and the Canon DR-5020/80c scanners support the use 
of two types of function control sheets. The control sheets can be used to 
change the paper size being scanned, as well as changing from single-sided 
to double-sided scanning. 

Batch detection sheets are used to enable several files to be placed in the 
scanner feeder at the same time with the batch detection sheets placed 
between them. The files will be automatically divided and records created in 
the ScanFile SBE folder. With each type of function sheet, you can elect to 
either keep or discard the function sheet (the sheet is not saved in ScanFile 
SBE), and to either stop or continue scanning when the function sheet is 
detected. 

The use of the function sheets is selected from the scanner setup. 
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Overview 
The correct indexing of documents is very important, as you have to rely on 
the index information to search and retrieve your documents later on. The 
more detailed your index information is, the better you will be able to narrow 
down your search results. 

The following indexing options are available: 

• Manual Indexing 
• Automatic Indexing 
• Import of index files 
 
This three options are standard features that are described later on in this 
chapter. Please refer to the Import chapter to read more about the import of 
index information from an external file. 

Several methods can be used at the same time, so that some index fields are 
filled manually as others are filled automatically by selected field properties. 

Manual Indexing 
When indexing manually, the user has to type in the index information. This 
can be done before documents are scanned or saved to the folder from the 
Postindex pool. The index information of documents in the folder can be 
changed at any time. Enter the information into the text boxes and confirm 
with Return. ScanFile SBE will automatically jump to the next index field and 
the user can continue with the index entry. 

Options such as the Duplicating field property and applying a thesaurus to a 
field help to cut out repetitive indexing and to ensure that index data such as 
names are typed correctly. Please refer to chapter Folders to read more 
about these field properties. 

Area Indexing 
With area indexing, for each field in the folder, ScanFile SBE can zoom and 
display a specific portion of the image. This is particularly useful when 
indexing batches of similar documents that have the indexing information in 
the same position. 

To do this, first you must ensure that the Area/PostIndexing feature is 
turned on within the General Settings. Then select the first document you 
want to index from the Hitlist, and choose the Edit option on the Folder 
toolbox. 
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Place the cursor in the first field, and then zoom and move the image within 
the image display window until the information relevant to the index field is 
being displayed. Type this information into the index field, and press Enter. 
The cursor will automatically move to the next field, and you can then zoom 
and move the image accordingly for the next field. Repeat this for all fields. 
When you press the Enter key in the last field, ScanFile SBE will 
automatically move to the first field of the next record in the Hitlist, and 
display the area of the image relevant to that field. 

Automatic Indexing 
ScanFile SBE offers various functions to auto fill index fields, depending on 
the index field and folder settings. Which settings are available and what 
index contents they generate can be found in the Folders chapter. 

Edit Index 
To edit the index information of an existing document, select the document in 
question in the Hitlist and switch to the Edit mode in the Folder Toolbox. The 
index information of the selected document are displayed and can be 
changed. Save changes by clicking on the Change Index button. The index 
information is saved, the Hitlist is updated. Another option is using the 
Return key in the last index field to save index information. The index of the 
document is saved, the Hitlist will be updated, but then ScanFile SBE will 
jump to the next document on the Hitlist and display first image and index 
information of the new document. 
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Overview 
Searching for documents within ScanFile is a straightforward and easy task.  
The standard document search tools in ScanFile are comprehensive, 
allowing you to perform range searches with AND/OR properties on more 
information than just the user-defined index fields created within a folder. 

Search 
The primary search screen is available from the Folder toolbox Search 
option, where the fields within the folder are presented, as well as the 
keywords if used. Just enter your search criteria, and pressing the Search 
button will produce a list of all the documents that matched the search 
criteria. At the same time, the first document in the matching list will be 
displayed. 

Wildcard Description 

* Denotes a string of any length (even 0) 

? Denotes any single character 

[x,y,z] Denotes one character , x or y or z ( [list of characters] ) 

[1-5] Denotes a single character of 1,2,3,4 or 5 (first character must 
be smaller than the second) 

 

With wildcards, there is no distinction between uppercase and lowercase. 

 
Examples: 

Wildcard Description 

* Puts all records into the Hitlist 

????? Shows all records with 5 characters in the field selected 

1* Shows all records beginning with 1, for example: 1, 11-19, 
100-199 s.o. 

M??le Shows records with Mable, Mowle etc 
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M*le Shows records with Mable , Mayle, Mole, Mowle, Mule, 
Module etc. 

 

Use of wildcards combined with other keyword fields reduces the Hitlist to a 
minimum and targets desired records as closely as possible. Several search 
criteria can be combined to narrow down the results. The search entries are 
logical AND combined, apart from keywords, which can be set to produce 
and AND or an OR search. 

Once the search has been performed it will return a Hitlist of the results of 
your search. Both the Hitlist and the Image Display windows can be sized as 
required. The size of the display on the PC will obviously affect how these 
windows can be shown. The fields within the Folder Toolbox will display the 
indexing information and the assigned keywords for the selected record from 
the Hitlist. The information shown in the Folder Toolbox will change to reflect 
the record selected. 

Extended Search 
The Extended Search option allows the user to find documents using the 
above information, as well as giving a more user-friendly display for range 
searches on any field in the folder. 

 

All the user-defined folder fields can have a range search performed upon 
them, as well as the Scan date and Change date fields. When the search is 
performed, the resultant Hitlist can be displayed with or without the additional 
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fields, by selecting the View extended Hitlist option. The additions in the 
extended hitlist show who the document was scanned by, the date it was 
scanned on, the name of any user that may have changed that document 
and the date that it was changed on. 

Multiple Index Search 
This feature allows you to search across selected index fields for the 
documents you require. To perform this type of search, select Multiple index 
search from the Search menu. You can then enter the search criteria and 
select the folder/library fields that you want to search across. Wildcard 
characters, such ‘*’ and ‘?’ can be used in the search criteria. Pressing the 
Search button will then display a Hitlist showing all the documents that 
matched the criteria used. 

Full Text Search 
Selecting Full text search from the Search menu allows you to search the 
word list resulting from full text recognition. The search screen will appear 
allowing you to type in the word or words to search for. Searches can include 
multiple words, and can be set to an AND or an OR search on the words 
entered. 

Selecting the page to view is exactly the same as previously, just highlight it 
in the Hitlist and the page will be displayed in the Image window. 
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Option Description 

Detailed Hitlist This option, when selected, will show a Hitlist record for 
each page that contains the word or words searched for. 
When not selected, the Hitlist record will correspond to 
the file the words were found in. 

Please note that a Detailed Hitlist can take a longer 
period of time to be generated due to each page having 
to be identified. 

Show number of 
matches 

With this selected, the number of times the word or words 
occur on the page or in the file will be displayed in the 
Hitlist. 

Phonetic Search With the Phonetic Search option words with a similar 
pronunciation to the searched word will be included in the 
search result. 

 

When you select a record on the Hitlist, by single clicking on it with the 
mouse, the document being displayed will automatically change to show the 
selected file. 

Hitlist 
The Hitlist, which shows the list of documents that matched the search 
criteria can be altered to show the information in a number of ways. The 
column width, and the order of the columns within the Hitlist can be 
amended. 
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To alter the column width, move the mouse pointer to the right edge of the 
column, within the column heading, and then hold the left mouse button down 
and drag the column edge to the required width. 

To move a column, hold down the left mouse button anywhere within the 
column heading and then drag the column to the required position. 

You can also select whether the Row Number and/or the Notes columns are 
displayed. This is done from the General Settings Options screen. If from 
this screen you select to save Column Settings, the changes you make will 
be saved, and each time you open a Hitlist, those settings will be used. They 
can be changed at any time, with the new settings then being saved. It is also 
possible to set Alternating Row Colours which will display the rows in 
alternate grey and blue lines instead of just grey. 

Hitlist menu 
From the Hitlist menu, several options are available that allow you to alter the 
display of the Hitlist information, and to also print, export copy and send 
documents. The Hitlist menu is available by pressing the right mouse button 
anywhere within the Hitlist window. The available options are: 

Option Description 

Sort Ascending / 
Descending 

Will sort the Hitlist by the data in the column over 
which the right mouse button was clicked. 

Print Hitlist Prints the Hitlist record information to the default 
printer 

Export to file Exports the Hitlist record information to a named file 

Copy to Clipboard Copies the Hitlist record information to the Windows 
Clipboard 

Font Select the font and font size the Hitlist will use. 

Move Moves all pages from a record. 

Copy Copies all pages from a record. 

Paste Pastes previously copied or moved pages into the 
selected record. 

Send to… Send selected Hitlist documents to folders, users, e-
mail, route, wallet and export. See below 
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Move to... Moves the selected document into a chosen folder 

Summarise column For Numeric Values: Calculates the total of the 
selected column 

Combine rows Either combines marked records or records with 
same index information. When marked the rows to 
be combined will adopt the index information in the 
row that was first selected by the mouse. 

Delete Deletes selected records and documents 

Filter image(s) Filters selected records 

OCR Performs Full Text or Zone OCR on the selected 
records and also gives option to Copy OCR text to 
the clipboard. 

Select Tool to select documents 

Close Close the Hitlist menu 

Send to… 
The Send to option from the Hitlist menu allows you to send a document or 
selected documents to a variety of destinations, which are explained below. 

Option Description 

ScanFile Folder Sends selected document(s) to another ScanFile Folder. 

Export to file Exports selected document(s) 

E-Mail Attaches selected document(s) to a new email message 

 

When selecting the File or Email option, the images can be saved as PDF 
format documents. This is enabled within General Settings -> Send to 
email. 

Combine rows 
The Combine Rows option on the Hitlist menu either will combine selected 
records within the folder or records with the same index information. When 
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marked the rows to be combined will adopt the index information in the row 
that was first selected. 

It is not possible to undo after performing this action. Please use this option 
with caution. 

OCR 
The OCR Option from the Hitlist menu allows you to either Full text OCR, or 
Zone OCR a single document, or selected documents. If you wish to perform 
batch OCR on all or new documents added to a folder, please use the 
options available from the main OCR menu. 

Option Description 

Full text recognition Performs Full Text OCR on selected documents 

Select Option 
When you click on a record on the Hitlist, or use the arrow keys to scroll 
through the records, the current record will be shown with a dark grey 
background. If you wish to select multiple records, to perform a specific task, 
this can be done in a number of ways. The column at the extreme left of the 
Hitlist is used to select records. 

To select a range of records, press the left mouse button in the left column of 
the Hitlist next to the first record to be selected, and then, while holding down 
the Shift key, click on the last record in the range. All records in the range 
will be highlighted in yellow. 

To select specific records, while holding down the CTRL key, click in the left 
column next to each record you wish to select. 

The Hitlist menu Select option can also be used for record selections. 

Option Description 

All Selects all documents in the Hitlist 

Toggle Inverts selection 

Remove Deselects all documents 
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Image Display 
All Documents are shown in the Image Diplay Window. ScanFile has a 
comprehensive set of tools available to change the way displayed images are 
shown. The images can be zoomed, rotated and also fit to the height or width 
of the image window. A file can be paged through by selecting the 
next/previous icons on the toolbar. 

 

 

 

Image Display Menu 
Pressing the right mouse button while in the document display window will 
open the document display menu. This allows you to perform actions on the 
page currently displayed. Several options available are the same as offered 
on the Hitlist menu, but will only apply to the displayed page. Please note that 
these options only apply to scanned documents. 

Option Description 

Image information Show file information about displayed image. 

Print/copy area Select an area on the page and print or copy to 
clipboard. 
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Convert to… OCR’s image and converts text to chosen file format. 

Create working 
copy 

Opens a secondary display window with the current 
page 

Fit image Sizes the page to fit within the display window 

Fit width Sizes the page to fit the width of the display window 

1:1 display Maximum zoom level 

Change image 
position 

Reorders the page within the document 

OCR Perform full text or zone OCR on the page, or copy 
the page text to the clipboard 

Move Moves the displayed image to the clipboard ready to 
paste to another record. 

Copy Copies the displayed image to the clipboard ready to 
paste to another record. 

Send to… Send page to another folder, user, export, email and 
wallet. 

Move to… Moves the selected document into a chosen folder 

Close Closes the document display menu 

Electronic Documents 
ScanFile supports the display of over 200 different electronic document file 
formats, such as Microsoft Office documents, Adobe PDF documents, HTML 
pages and graphic format files, such as AutoCAD and CorelDraw. 

When viewing multi-page documents such as PDF files and PowerPoint 
presentations, the tools to move from page to page, or worksheet to 
worksheet will be displayed at the bottom of the viewing window. For 
documents such as Word files and text files, these can be scrolled through 
using the scroll bar on the right of the viewing window. 
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Electronic Document Display Menu 
The options displayed when you right-click on an electronic document will be 
different to those available when viewing a black & white or colour image. 

Optionen Description 

To the clipboard Copies the selection to the Windows clipboard 

Print Prints the currently displayed document 

Display Selects to display the document in Draft. Normal or 
Preview mode 

Options Settings that affect the copying, display and printing of 
documents 

Launch application Launches the documents associated application 
(if available) 

Viewing Multiple Documents 
Up to three secondary image display windows can be opened in addition to 
the standard image display window. To open a secondary display window, 
right click on the image in the standard display window and choose Create 
Working Copy. This will open a secondary display window showing the 
image currently displayed in the standard display window. 

The secondary display windows are totally independent of the standard 
display window, and of the folder, and do not relate to a particular file. It is not 
possible to page through a document from a secondary window. 

The secondary windows will remain open until they are manually closed, or 
ScanFile is closed. 

Searching and Viewing documents • Page 65 



ScanFile SBE User Guide 
FastPics 

 

FastPics 
FastPics are thumbnail representations of the pages within a file that can be 
displayed. The page you then want to view can be selected and shown in the 
Image window. FastPics will also show whether a page was the front or back 
of a double sided document, and you can also tag pages for printing or 
exporting by clicking when the mouse pointer turns to a tick over the FastPic 
image of the page. 

Page 66 • Searching and Viewing documents 



ScanFile SBE User Guide 
FastPics 

 

Electronic documents, such as word processing files, will show a page with 
the reference EDOC. COLD information pages will have the word COLD. 

FastPics Menu 
Pressing the right mouse button within the Thumbnail window will open the 
Thumbnail option menu, which allows you to perform actions on the selected 
pages within the document. The options available are the same as offered on 
the Hitlist menu, but will only apply to the pages within the document that 
have been selected. 

Option Description 

OCR Full text or zone recognition can be performed on the 
selected pages. The OCR’d text can also be copied to 
the clipboard 

Move Mark the selected pages for moving to another record 
within the folder 

Copy Copies the selected pages for pasting to another record 
within the folder 

Send to… Selected pages can be sent to another folder, a user, 
exported, or emailed 
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Move to... Moves the selected document into a chosen folder 

Select Selects all or no pages, or inverts the current selection 

Close Close the option menu 
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Import 
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Overview 
There are several methods for importing and sending documents to ScanFile 
SBE folders. Documents can also be saved in their original format or 
alternatively converted to TIFF format. This chapter describes different 
methods of importing electronic documents into ScanFile SBE folders. 

TIFFWriter 
TIFFWriter is a Windows Printer driver that allows you to 'print' any document 
from any Windows application into a ScanFile SBE folder. Each page will be 
analysed by TIFFWriter and will either be processed as a colour or black & 
white page. If a page has ANY colour content, it will be converted to JPEG 
format. Pages with black & white only content will be converted to 
compressed TIF format.  

TIFFWriter is an option for ScanFile SBE and can be selected for installation 
during the installation process of ScanFile SBE. If the option has not been 
purchased, it will report that it is not licensed. 

To 'print' a document into ScanFile SBE using TIFFWriter, from a Windows 
application, choose the Print option and select the ScanFile SBE 
TIFFWriter printer. From the printer Properties dialogue, the standard 
options such as paper size and orientation single or double sided and 
resolution can be set. Pressing the OK button of the Print dialogue will 
display the Index screen. 
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From this display, you can select which folder you want to put the document 
into. Once you have selected the folder, the folder fields (and keywords if 
assigned to the folder) will be displayed. You can then type index information 
relevant to the document, or you can choose to place the document into the 
Post Index pool. 

Once you have indexed the document, or selected to put the document into 
the Post Index Pool, pressing Save will put the document in the folder. 

Collect Mode 
TIFFWriter also has a Collect Mode, which allows you to print multiple 
documents using TIFFWriter before saving them to ScanFile SBE folders.  

To activate this feature, once you have printed the first document and the 
Index screen has been displayed, press the Collect Mode button. The Index 
display will then change to just show an End Collection button. While this is 
displayed you can print using TIFFWriter from Windows applications without 
having to store each printout at once. 
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When you have finished printing your documents, press the End Collection 
button, and the screen will return to the standard Index display. You can 
review the documents held with the collection by pressing the Show 
Collection button, which will then open the Collecting pages screen. 

 

You can page through the collected documents using the navigation buttons 
at the bottom of the preview window, and select the document to view from 
the Jump to document drop down list. 

You can also select to delete pages from a document by displaying the page 
and pressing the Delete image button, or you can delete a whole document 
using the Delete document button. All the documents in the collection will be 
saved to one ScanFile SBE folder document, or they can be placed in the 
folder Postindex pool. 

Explorer Send To 
Within Microsoft Windows, a new option will have been added to the 
Windows Explorer pop-up menu: Send To->Electronic Document Support 
after the installation of ScanFile SBE. This allows you to highlight files from 
within Explorer, and then choose the ScanFile SBE folder you wish to put 
them into. 
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After highlighting the document(s) you wish to put into ScanFile SBE, press 
the right mouse button and choose the Send To option. Choosing the 
ScanFile SBE Electronic Document Support option will display the same 
dialogue as for TIFFWriter, but it handles the documents in a different way. 
The documents are not converted to TIFF or JPEG, but saved to a ScanFile 
SBE folder in their original file format. 

MS Office Integration 
The Office integration tools, which you can select during the installation of 
ScanFile SBE, allow you to file documents to ScanFile SBE folders from 
within Microsoft Office. The tools support Microsoft Word and Excel 97 and 
Microsoft Word, Excel, Access, PowerPoint and Outlook 2000, XP and 2003. 
The documents will be saved with ScanFile SBE in their original format, 
unlike TIFFWriter which converts the documents to TIFF format.  Two toolbar 
icons will be added to the programs, and these are shown below. 
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Send To ScanFile SBE 
The Save to ScanFile SBE icon will open the Index screen as detailed in the 
TIFFWriter option and Explorer Send To option. The functionality of the 
Index window is the same as described in these chapters. 

Print and Save To ScanFile SBE 
This option performs two functions: it will print the document to your selected 
printer and open the Index screen to allow you to save the document to 
ScanFile SBE. 
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Overview 
The General Settings screen can be found under Options -> General 
Settings. This allows you to set various options that will affect the quality of 
the displayed image, change how the Hit List is displayed, the main window 
background, and other options that change the Keywords display and image 
print.  

These can be changed at any time whilst using ScanFile SBE, but some 
options such as Show additional Toolbar will only take effect when 
ScanFile SBE is restarted. 

 

Image 
There are more settings to influence the image display in ScanFile SBE. 
Following table lists the options and gives a brief description: 
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Option Description 

Skip back pages When enabled, it will stop the reverse side of a 
double-sided scanned document from being displayed 
when browsing through a file. 

Rotate Back Page If a double-sided page has been scanned, and the 
reverse side of the document is 'upside down' in 
relation to the front side, the option will display the 
reverse side of all files in the correct orientation. 

Hide Annotations Allows you to hide annotations added to a scanned 
page. A pencil symbol in the upper left corner will then 
indicate if there is a hidden annotation belonging to 
the image. 

Use Stellent Viewer Allows you to switch off the display of electronic 
documents with the Stellent Viewer, which can take 
some time if the documents are large. If this viewer is 
not used, the electronic documents will appear as an 
iconic symbol on the image window. With a double 
click on the icon the documents can be displayed in 
their corresponding applications, as long as they are 
installed. 

 

The vast majority of PC monitors are unable to display a document at its 
scanned resolution. As an example, an A4 page scanned at 200dpi results in 
an image 1664 pixels wide by 2532 pixels in length. This means that if the 
monitor resolution is lower than this, information from the image has to be 
'removed' to be able to display it. This can then result in a loss of quality in 
the displayed image. ScanFile SBE has three image display modes which 
can be applied so that optimum display quality can be achieved: 

Option Description 

Greyscale Applies 4 levels of greyscale to enhance the displayed 
image 

Bitonal Applies one level of grey to enhance the image 

Black / White Displays the image with no enhancement 
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When the scanned image is displayed at 1:1 level (one screen pixel for 
each scanned pixel), the Greyscale and Bitonal enhancements are not 
applied. 

Printing 
Following settings change the print settings of ScanFile SBE: 

Option Description 

Exact Scale Print When printing documents, pages will be printed at the 
exact scale at which they were scanned. This may 
mean that because a printer has a non-printable 
border, the page being printed will not fit onto one A4 
page. When this option is not enabled, ScanFile SBE 
will ensure that an A4 page will fit on a single printed 
page by slightly reducing the size. 

Automatic 
Orientation  

When enabled, ScanFile SBE will test and select 
automatically which orientation will be best for the 
document to be printed in. 

Ignore Duplex mode When scanning double sided documents, ScanFile 
SBE records whether a stored page was the front or 
back of a page. When printing these to a double-sided 
printer, if the Ignore Duplex mode is disabled, 
ScanFile SBE will print each page as it was scanned -
front pages will be printed on the front of a sheet, back 
pages will be printed on the back of a sheet. When 
this mode is enabled the pages will be printed in 
straight sequence. 

User, Date and 
Time 

The option will print the name of the computer, the 
user, and the date & time the document was printed at 
the top of each sheet. 

Page numbering When activated, ScanFile SBE prints the page 
number and the total number of pages at the top of 
each sheet. 

Text Annotations When enabled, text annotations can be printed on a 
separate sheet to the image when this option is 
selected. 

Print index 
information 

When enabled, index information of a document will 
be printed at the top of each sheet. 
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Keywords 
If a keyword list has been applied to a folder or library, you can choose how 
this is displayed, and how the keyword search will operate. 

Option Description 

Clear Selected 
Keywords 

If the option is enabled, when the Clear fields button is 
pressed in a folder or library, the currently highlighted 
keywords will be de-selected. If this option is disabled, 
the keywords will remain selected. 

Hide Keyword List When a folder or library is open, this option, when 
selected, will not show the keyword list next to the 
folder or library fields. 

Display Keywords 
as Text 

Enabled, the keyword list will be shown in list format. 
Otherwise the text will be shown in the cell box. One 
of the features of the Canofile is index cells, which 
work in the same way as keywords. These cells can 
have graphic images scanned into them and can be 
displayed using cells. 

AND / OR When using keywords to search for documents, 
multiple keywords can be selected. By choosing either 
the AND or the OR option, the search will find 
documents that have had ALL the selected keywords 
applied to them, or will find documents that have had 
ANY of the keywords applied to them. 

Formats 

Send to Email 
This option allows you to select how images are sent to an e-mail message. 
If a document has multiple pages, the images can be put into the new 
message as either single page TIFF files, a multi-page TIFF file or as a PDF 
File. If a document is of mixed format – it also contains colour documents or 
Word/Excel files – these will be separate to the file(s). This setting also 
affects the Save to File option. 
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Option Description 

Normal Mode In this case all files that are sent and automatically 
appended to an Email, remain in there original format. 

Multipage TIFF In this mode the system stores single TIFF files in a 
multipage TIFF files. In case a document contains 
only TIFF files, one multipage TIFF file is appended to 
the Email. 

In case a document contains a mixture of file formats, 
it will still collect consecutive TIFF pages and COLD 
pages in one file, all other formats remain in their 
original format. 

Postindex 
This option sets the mode and storage location for the post index pool. 

Option Description 

Normal Mode There is one post index pool for each ScanFile SBE 
folder, which is physically stored in the subdirectory of 
each ScanFile SBE folder. 

Customized Mode There is one central post index pool for all ScanFile 
SBE folders. The storage location of this central pool 
can be defined by clicking on the button. 

Be aware, that in a network situation this can lead to 
problems, when several people are working 
simultaneously with a central pool. 

Hitlist 
The Hitlist is used to display the results of a document search. Four options 
are available, to alter its appearance and functionality. 
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Option Description 

Display Hitlist 
Numbers 

The records in the Hitlist will be numbered in 
ascending order. This will be in the first column of the 
Hitlist. 

Show Notes 
Column 

Adds a column to the end of the Hitlist. The Notes 
column will show whether records have memos 
applied to them, or that the records are hidden. 
Records with a memo attached will show a 'M' in the 
Notes column. Records hidden for users of the group 
View will have an 'X'. 

Save Column 
settings 

If selected, it allows each user, for each folder they 
have access to, to customize how the Hitlist is 
displayed. The order of the columns in the Hitlist can 
be changed, as well as the column widths. These 
settings will be saved with the folder or library being 
accessed. 

Alternating Row 
Colours 

The setting changes the view of the hitlist from plain 
grey lines to alternating blue and grey lines, this can 
help when viewing similar index information. 

Group to PDF In this mode pages in TIFF, JPEG and COLD format 
will be converted into a PDF file containing these 
pages as graphics. 

Electronic documents are appended in their original 
format. 

Other Settings 
Option Beschreibung 

Memo note – view / 
hidden creator 

Automatically enters a short entry into the memo of a 
document, noting who and when locked or unlocked 
the display of a document. 

Use Global Scanner 
Settings 

Activated, all user related scanner settings are ignored 
and the scanner settings of user ADMIN will be 
applied for every folder and user. 
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Display Inactive 
Buttons 

With this option, you can choose whether buttons on 
the toolbars are displayed or not, dependent on 
whether they are applicable to the function being 
carried out. If this option is not selected, toolbar 
buttons will be greyed out when not applicable. 

Display Additional 
Toolbar 

The toolbar along the top of the main ScanFile SBE 
window will be shown when the option is selected. 

Hide Tooltips Tool tips are short descriptions of the functions of the 
toolbar buttons. They will be displayed if the mouse 
cursor is left over a toolbar button for a moment. You 
can select whether these are displayed or not by 
enabling/disabling this option. 

Automatic Date in 
Memo field 

Enabled, this will add the date and time of a memo to 
a memo applied to a document. 

Automatically Clear 
Pooldrive 

The option is used by the Prepare CD function. When 
selected, the existing contents of the pool drive will be 
deleted prior to the new information being written to it. 

Area/Post-indexing 
function 

The Area/Post-indexing function, when selected, 
will allow you to set an area of the image to move and 
zoom to for each field in the folder. This is used during 
index editing, and when indexing documents from the 
Post-Index pool. 

Check Number of 
Barcodes 

When scanning bar-coded documents, the contents of 
the barcode can be read during scanning and inserted 
into fields in the folder. You can select whether 
ScanFile SBE will check if the correct number of 
barcodes has been read from the document, in 
relation to the number of fields in the folder that have 
been set with the barcode property. 

Auto Index failed 
barcode read with X 

When scanning single page bar-coded documents, if 
ScanFile SBE fails to read a barcode from a page, an 
'X' can be placed in the folder barcode field, to identify 
the document for later indexing. The Auto Index 
failed barcode read with X option selects this. If this 
option is not selected, and ScanFile SBE was unable 
to read a barcode, scanning will pause and you will be 
prompted to type in the index information into the 
barcode field. 
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Choose Background 
The default display for the main ScanFile SBE window is a grey background. 
Each user can change this by selecting the Choose Background button in 
the General Settings. You can then select whether you wish to choose a 
colour for the background, or to apply an image to the main screen 
background. 

Colour 
To choose a colour press the Choose Colour button, and the following 
dialogue will be displayed: 

 

You can then choose the colour you wish, and press OK. You will then be 
returned to the Choose background screen shown on the previous page. 

The available colours will be dependent upon the settings of the display 
adaptor. 

Image 
Selecting the Choose Image option will allow you to apply a Bitmap (.BMP) 
file to be displayed in the main image window. The top left corner of the 
selected bitmap will be in the top left corner of the main ScanFile SBE 
screen. 
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Overview 
Further settings are available within ScanFile SBE that allow you to select the 
language ScanFile SBE uses, which barcode to read, and other scanning 
related functions. These are described below. 

Choose language 
When installing ScanFile SBE, you will be asked to select the language 
required, but this can be changed at any time by selecting Choose 
Language from the Options menu. Available languages are: 

Before the new language will take effect, ScanFile SBE must be closed down 
and restarted. 

The Far East languages Japanese, Korean and Chinese are available in 
special setups. 

Choose brightness 
Select Choose brightness from the Options menu to assign predefined 
brightness levels used during scanning to the function keys F2 – F6. Where, 
for example, documents have different background colours, and the scan 
quality using the automatic mode of the scanner is insufficient, manually set 
values can be applied. By pressing the appropriate function key, that 
brightness level will be used during scanning. 

 

Obviously, the setting of these values is a matter of trial and error, but once 
the correct values are found, they need not be changed. This can be 
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overridden by using either the automatic mode or by selecting the brightness 
level using the control on the toolbar. 

A function key value of zero will, when that key is pressed, reactivate the 
scanner's automatic brightness function. 

Setup Filter 
This option enables you to enhance the quality of a scanned page by 
applying predefined filter options, or by creating your own filter settings. 
These settings can be entered when selecting Setup Filter. from the 
Options menu. The filter can be applied either after scanning by selecting 
Edit -> Use Filter, or during scanning if the Use Filter option is selected. 

Up to three user defined filter settings can be created and saved. These can 
then be applied by selecting them from the drop down lists on the right side 
of the Filter Settings wind90ow. Up to six filters (standard or user defined) 
can be applied at any time, and they will be actioned in the order – from top 
to bottom – that they are selected in the drop down lists. 

 

Pre-defined Filters 
There are six pre-defined filters that can be applied, and these are described 
below. 
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Filter Description 

Noise Removal This will remove single black & white pixels 

Horizontal line 
removal 

This will remove horizontal lines 

Vertical Line removal This removes vertical lines 

Brighten page This will brighten the page 

Darken page This darkens the page 

Complete Lines Attempts to complete horizontal & vertical lines 

Softer edge Will soften edges of words and graphics, blending 
them with their surroundings 

Harder edge More clearly defines the edges of graphics, boxes 
and text. 

 

The following example shows the result of filtering using Noise removal. 
This filter favours white or black areas and removes isolated white and black 
pixels. As a result the contrast and readability is improved whereas the 
storage space is reduced. 

 

User Defined Filters 
The filter algorithm calculates the brightness of each pixel of an image. With 
black and white images, the brightness value of each pixel is binary: the 
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value of a black pixel is 1 and of a white pixel 0. The brightness value to be 
allocated to a pixel is calculated by the weighted sum of the neighbouring 
pixels. These weighting factors give a ‘coefficient’ to a filter. Since the 
calculated brightness values have to be assigned either to black (1) or white 
(0) a threshold for the decision must be defined. 

1 1 1 

1 1 1 

1 1 1 

 

1 2 1 

2 2 2 

1 2 1 

 

The setting of these p
i.e. the image resolu
Filtering generally en
microfilm images and

Please note, it is poss
document completely
NEVER turn the Us
settings are correct fo
scanning an example
Image from the Edit 
the filtered image. 

Fast Search
With the option Fast
against specific field
substantially reduce s
of index records, wh
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To set a binary index
that the folder or libr
menu, and the followi
With his filter parameters and a threshold of e.g.3
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With these parameters and a threshold of 4 thin
interrupted horizontal and vertical lines will be
closed. 
arameters depends on the quality of scanned images, 
tion, the zoom factor and the brightness of the image. 
hances the screen display readability of low contrast 
 reduces storage requirement dramatically. 

ible, with the incorrect use of the filter to turn a scanned 
 black, or completely white. When working with filters, 
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, amending the filter settings, and then selecting Filter 
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 for a field within a folder or library, first of all make sure 
ary is open. Then select Fast Search from the Edit  
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Select the field to set a binary index on, and then press OK. A binary index 
will then be created for that field. 

A field set with a binary index can adversely affect the import of new 
records. This is especially so when importing folders into libraries. It is 
therefore wise to switch the binary index OFF before importing folders into 
libraries, and then to switch the binary index back on. 
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General Information 
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Overview 
This chapter describes several options which provide information about the 
installed ScanFile SBE version and image information. 

ScanFile SBE Version 
This utility is available from Help -> Info menu. A window will be displayed, 
giving you the version number of ScanFile SBE, name of the computer and 
logged in user. Additionally you can display system information by clicking on 
the button Info. 

 

Image Information 
When a page from a document is displayed, information about that page can 
be obtained by choosing Image Information from the Help menu.  

The location, and file number within the folder will be displayed, as well as 
such information as resolution, and compressed and uncompressed size. 
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Overview 
This is an option for ScanFile SBE is able to perform a full text OCR reading 
on a scanned document. 

Full text recognition creates a searchable database, allowing to find pages of 
documents that specific words appear on. Electronic documents containing 
text can be read as well. Since this data is already text based, the full text 
reading is very fast and reliable. 

Full Text Recognition 
Using this option every scanned page of a ScanFile SBE folder is read, and 
recognised words will be saved in a database. This database is attached to 
the folder, and can be searched by anyone who has ScanFile SBE. 

You do NOT need the OCR module to do a Full Text Search; you only 
need the OCR module to perform the recognition in the first place. 

o do a fulltext recognition, open the relevant folder and click to menu  
OCR -> Full text recognition. 

You can select whether you wish to OCR all pages in the folder or just the 
new pages – the pages added since the OCR was last run. 

 

Once the recognition starts, the progress can be monitored. The information 
displayed includes a recognition ratio, showing the perceived reliability of the 
process. Obviously, the OCR recognition will have problems with bad quality 
documents, so always ensure that the documents to be OCR’d are of decent 
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quality. It is also wise to have scanned them at a minimum of 300x300dpi for 
best results. 

Read Selected Documents or Pages 
The process described above will OCR all the pages within a folder, or the 
pages added to the folder since Full Text OCR was last run. Alternatively, 
you can OCR individual or selected pages of a record, or single or selected 
records within a folder. To OCR records or pages, use the OCR menu option, 
which is shown when right-clicking in the relevant window. 

Window Description 

Hitlist Window Selected record or records 

Image Window Displayed page 

FastPics Window Selected page or pages 

 

Edit Wordlist 
When performing a full text OCR, there will be some words that you would 
not wish to search on, and that just take up space within the OCR database. 
These are generally words such as 'that', 'the', 'and' etc. These can be set to 
be ignored by adding them to the OCR wordlist, which you can open by 
selecting the Edit wordlist option on the OCR menu. Per default this wordlist 
is empty and no words are filtered from the text read. 
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How to perform a full text search is described in chapter Searching and 
Viewing Documents. 
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Microfilm Scanning 
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Overview 
The Canon microfilm scanners can be equipped either with a fiche carrier or 
a roll film retrieval FS Controller III. to allow batch scanning of the documents 
held on the film or fiche. 

Fiche Carrier 
After the user has entered the index information and positioned the fiche 
carrier to the relevant frame on the fiche, the scanning process is started by 
clicking on either Batch scan or Single page scanning. Using a fiche 
carrier, the Feeder/manual button is ignored. 

When a scan is finished (the scanned pages and the relevant data record 
have not yet been saved), the user must decide on the step required next. 

FS Controller III 
The FS Controller II is an automatic roll film carrier that can be directly 
controlled from ScanFile SBE. 

Single Page Scanning – Microfilm 
Single Page scanning will create one record for each page scanned. You can 
switch between manual or automatic mode, dependent on the carrier. 

Fiche Carrier 
Using the fiche carrier, you need to go to the page to scan manually. 

• Insert fiche to be scanned 
• Position to the relevant fiche frame 
• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

barcode, counting or duplicating index fields) 
• Start scanning process by clicking on the Single page scanning button 
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FS Controller III 
The FS Controller III can scan in a given number of frames automatically. It 
can be switched between automatic and manual feed. 

Manual Mode 

In this mode the pages are manually selected via the keyboard or knob of the 
FS III and scanned as single page records. 

• Insert the film to be scanned 
• Position the FS III to the frame to be scanned (with keyboard or turning 

knob of FS III) 
• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

barcode, counting or duplicating index fields). 
• Start scan by clicking on the Single page scanning button 
 
Feeder Mode 

In this mode a user-definable number of frames is scanned automatically and 
saved as separate records. 

With this option automatic indexing (barcode, counting or duplicating fields) 
should be set, as it is not possible to key in index information during the 
scanning process. The index can also be keyed in or edited later. 
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• Group pages by pages (P) 
(scans and stores images as single page records between Page blip 
numbers entered) 

• Group pages by File (F) 
 (scans and stores images as single page records between File blip 
numbers entered) 

• Group pages by File (F und B) 
(scans and stores images as single page records between File-and batch 
blip numbers entered) 

• Group pages by Batch (B) 
(scans and stores images as single page records between Batch blip 
numbers entered) 

 

Be sure that the mode of the FS Controller III for blip reading is set properly. 
For more information on the FS Controller III, see the MS300 / MS350 / 
MS400 / MS500 / MS800 Scanner Configuration manual, or the FS Carrier 
III manual. 

Batch Scanning - Microfilm 
Batch scanning will create a document containing multiple scanned pages. 

Manual Mode 
Using manual mode, the user can scan several images into a batch record 
from roll film. ScanFile SBE will combine these single images to one 
document. 

• Insert the film to be scanned into the FS Controller III 
• Set roll film retrieval to the first image (by the keyboard or knob of the FS 

III) 
• Set Zoom and focus 
• Key in the index information (if not created automatically by barcode or by 

duplicating or counting fields). 
• Start scanning by clicking on the Batch Scan button. 
• Select next frame if necessary and click on Continue scanning. Repeat 

this step until end of batch 
• To end batch click on Save scanned pages 

Feeder Mode 
In this mode a user-definable number of images is scanned sequentially and 
stored as one batch (document). 
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The index is either entered manually or created automatically using barcode, 
counting or duplicating fields. The index can also be keyed in or edited later. 

The images to be scanned can be selected according to the blips (B,F,P) on 
film: 

• Group pages by pages (P) 
(scans and stores images into one batch between Page blip numbers 
entered) 

• Group pages by File (F) 
(scans and stores images between File blip numbers entered into 
batches) 

• Group pages by File (F und B) 
(scans and stores images between File blip and batch blip numbers 
entered into batches) 

• Group pages by Batch (B) 
(scans and stores images between Batch blip numbers entered into 
batches) 

 

Be sure that the mode for blip recognition on the FS Controller III is set 
properly. For more information on the FS Controller III, see the MS300 / 
MS350 / MS400 / MS500 / MS800 Scanner Configuration manual, or the FS 
Carrier III manual 
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Printing and Email 
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Overview 
ScanFile SBE has comprehensive facilities for the printing of scanned 
documents as well as for exporting both indexes and documents for use 
outside of ScanFile SBE. 

Printing 
With ScanFile SBE, you can choose from several options for printing: 

• Currently displayed page of a document 
• All pages in the selected document 
• Range of pages from the selected document 
• Selected pages from the selected document 
• Selected documents  
• Hitlist 
• Audit Trail Events 
 
Selecting the Print Image option from the File menu allows you to print the 
currently selected file, or a range of pages from the currently selected file. It 
also gives you the opportunity to choose the printer you wish to print to. 

The Print button in the toolbar has different functions depending on which 
window is active at the time it is pressed. 

Window Action 

Image Window Displayed image is printed 

Hitlist Window The selected hitlist documents are printed 

Fastpic Window The selected images from the current document are 
printed 

 

Selecting Print Hitlist from the File menu will print the Hitlist. 

 

When printing scanned images, various options are available. These can 
be selected from the General Settings dialogue. The options and their 
explanations are listed in the chapter General Settings. 
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Email 
Use the pop-up menu of the hitlist to create an email with the selected 
document attached. Therefore right-click on a document in ScanFile SBE, 
choose Send To -> E-mail option and ScanFile SBE opens a new message 
window in the PC's default e-mail software, and attaches the selected 
document(s). 

Scanned, multi-page documents can be converted to single page Tiff, multi-
page Tiff’s or PDF file, depending upon the option selected in General 
Settings. Electronic documents will be copied in their native format. 
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Overview 
Documents and index information can be imported or sent to a ScanFile SBE 
folder in a number of ways and formats. Any format of document can be held 
in a ScanFile SBE folder and viewed from either the folder or a library. 
Explained earlier in this Guide were TIFFWriter and the Send to ScanFile 
SBE options. This chapter describes the import features available. There are 
three choices for importing: 

• Files only 
• Files and Index information 
• Index information only 

Import Files 
Select Import -> Files from the File menu, and the import screen will be 
shown. 

 

Any format file can be selected for import,.Select the drive and directory 
where the files to be imported are, highlight the file or files to be imported, 
and then click on OK. The files will then be placed in the Postindex pool. 
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Index Information 
The Import index function is used to fill index records in existing folder 
documents with additional information. As an example, bar-coded documents 
may have been scanned, with the barcode representing a Project Number. 
An external can have that number in it plus the Document Name, Document 
No etc. The Project Number can be set to be the Connect field, and the 
additional index information will then be imported to the appropriate records. 
To open the Import select the File –> Import -> Index menu. 

 

The example text file shows 10 records, with the index information within the 
records being delimited by commas. The first field is the Project Number – 
the Connect field – which already exists in the folder. The Import will use this 
to search for matching records, and then fill the other folder fields with the 
additional information. 

From the File menu, select Import Index, and then select the data file that 
holds the index information, the screen above will be shown. The Folder 
fields will be displayed on the left, and the fields from the import file can be 
matched to these. It is very important that the No. of fields, parameter is 
correctly set, as well as any field separators and delimiters. Once the import 
has been set up, the import can be started by pressing the OK button. 
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Files & Index Information 
Files and their associated index information can be directly imported into a 
ScanFile SBE folder. An ASCII file may hold the index details for project 
information, and will also hold references as to which TIFF files belong to a 
particular record. This can be read into ScanFile SBE, the index records 
created automatically, and the images imported and associated with the 
correct index record. 

 

This option is also used to import index information with no associated files. 
This allows you to create 0 page records in a folder to add documents to at 
a later date. 

File Format 
It is very important when importing index information from a text file that the 
index records are formatted correctly within that file. 

Firstly, each record must start on a new line within the text file. This can be 
easily verified by opening the file in a text viewer such as Notepad. When 
exporting data from other applications, most of the applications will 
automatically start a new record on a new line. They do this by adding the 
CR (Carriage Return) and LF (Line Feed) ASCII characters to the end of 
each record. 
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The format of each record within the import file is also very important. When 
importing multiple index fields into each record, ScanFile SBE expects each 
field’s index information to be separated by a character. The most common 
character used for this is a comma (,). See the following example: 

12345,Project XY,Phase X,Customer Y 

The comma (,) separates the four fields: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X 
• Field #4: Customer Y 
 
These four fields can be assigned to the index fields in the import folder. The 
options No. of fields and Field separator must be filled with a 4 and a 
comma (,) so that ScanFile SBE is able to import the index information 
correctly. As a Field separator every character that is not part of the index 
information itself can be used. If the Field separator occurs in the index 
information a Field delimiter can must be added to separate the fields. The 
Field delimiter must be the first and the last character in each field. If so all 
characters between the field delimiter characters, even a character that is 
used as Field separator, will be used as index information. 

“12345 “,“Project XY“,“Phase X,Y“,“Customer Y “ 

The comma (,) separates the four fields: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
 
The example uses a quote sign (“) as Field delimiter. Without the Field 
delimiter the comma (,) in field #3 would also be interpreted as Field 
separator and the field content would be divided into two different fields. 

In addition to the import of index information ScanFile SBE is also able to 
import index information and related files from. In this case the index file must 
contain the index information and the document filenames. All files must be 
located in the same path as the index file itself, or have the path to the file 
location as part of the filename. The following example shows a line of an 
import file to import index information and their related files. 

“12345 “,“Project XY“,“Phase X,Y“,“Customer Y“,”01.tif”,”02.xls” 
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ScanFile SBE would find the following information: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
•  
• File #1: 01.tif 
• File #2: 02.xls 
 
The example shows the index information and tow related files. The file 
named 01.tif is a TIFF file that is directly imported to the chosen folder. When 
importing TIFF files, these can be either single or multi-page Group 4 TIFF 
files. The second file named 02.xls is a Excel file that will be appended to the 
document after the last page of the TIFF file. 
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Overview 
ScanFile SBE has built-in support for the following Canon scanning devices: 

• DR-3020 • DR-2050C • DR-7080C 
• DR-3060 • DR-2080C • MS300 
• DR-3080C • DR-2580C • MS350 
• DR-3080CII • DR-5010C • MS400 
• DR-5020 • DR-6080 • MS800 
• DR-5060F • DR-7580 • CR-180 
• DR-5080C • DR-9080C • CF510 

 

Additionally, ScanFile SBE supports the Panasonic KV-S2026C directly, and 
also supports any TWAIN and Kofax device. 

SCSI Connected Scanners 
With some of the built-in drivers, if the scanner is using a SCSI connection, 
the SCSI adaptor the scanner is attached to must be specified. This can be 
done by selecting from the top drop-down list in Select Scanner SCSI ID. If 
there is only one SCSI adaptor card installed in the PC, this will be selected 
by default. 

The scanner itself then has to be selected. A SCSI Adaptor can have up to 7 
SCSI devices attached to it. They are each identified by a SCSI ID in the 
range 0-7. Normally, the SCSI adaptor itself will be set to SCSI ID 7. This 
leaves 0-6 for other devices.  

The correct SCSI ID for the scanner can be selected by using the second 
drop-down list in Select Scanner SCSI ID. For any SCSI device attached to 
the selected adaptor card, a description of what the device is will be 
displayed next to the SCSI ID 

Scanning Resolution 
Any scanning device has the ability to scan documents at different 
resolutions. These are measured in Dots per Inch (Dpi). In the majority of 
scanners, vertical and horizontal resolutions will be the same, although 
certain Canon DR scanners can scan at split resolutions. 

The resolution that a document is scanned at will have two effects. The 
higher the scan resolution, the better the quality of the image that will be 
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produced. Higher scan resolutions will produce larger file sizes for a scanned 
image. With file compression which ScanFile SBE utilises, the file size can be 
reduced. 

The resolution chosen to scan particular documents will very much depend 
upon the type of document being scanned, its quality, whether it is to be 'live' 
or 'archive' filing, and user preference. 

Test Scan 
The Test scan function is available within the inbuilt Canon scanner drivers, 
and allows you to scan a document with your selected settings, to see 
whether these settings are correct. 

Place a document in the scanner feeder and then press the Test Scan 
button. The document will then be displayed in the Test Scan Display 
window. 

The image quality can be checked from this window. The Plus (+) and Minus 
(-) signs in the bottom left and right of the Test scan window allow you to 
enlarge and reduce the size of the image. Pressing the O allows a box zoom 
- draw a box around the area you wish to enlarge. The # will display the 
complete image in the Test scan window. The image can be moved around 
within the window by pressing and holding the right mouse button, while the 
cursor is over the Test Scan window, then dragging the mouse around the 
window. 

Scanner Control Sheets 
The Canon DR-3020, DR5020 and DR05080c are delivered with two types of 
control sheets. The first type can change the scanner settings, whilst the 
second will affect how the documents are stored. The Control sheets can be 
inserted between pages/files and, during scanning, will affect either how the 
documents are scanned or how they are filed. 

For each type of control sheet, four options are available 

• • Detect & Scan, Continue Scanning 
• • Detect & Skip, Continue Scanning 
• • Detect & Scan, Stop Scanning 
• • Detect & Skip, Stop Scanning 
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If the Detect & Scan option is chosen, the control sheet is stored in the 
ScanFile SBE folder. If the Detect & Skip option is selected, the control 
sheet is not stored in the ScanFile SBE folder. 

Job Separation control sheets are used to divide documents placed in the 
scanner feeder into separate files when scanned. Place a Job Separation 
sheet between each file, choose the required Batch Detection mode, and 
then scan the documents. 

When a control sheet has been detected, scanning can either continue or 
stop. You may wish to stop scanning so as to enter additional indexing 
information. Alternatively, you may wish to scan everything and then index it. 
In this case, choose the Continue Scanning option. 

The Function Control sheets affect the operation of the scanner. With these 
sheets, during scanning, the scanning mode can be changed from Text Mode 
to Photo Mode, or vice versa, by the use of the appropriate control sheet. 
Using The Simplex and Duplex control sheets changes the scanning mode to 
either single or double-sided scanning. 

Scanner Configuration 
There are many options that can be selected for the scanners, and these are 
split over several screens which are selected from Scanner Setup. The most 
used options are collected together on the first screen displayed when 
Scanner Setup is selected. The options of the different scanners are 
detailed below. 

Canon DR-6080, 7580 & 9080c 
The DR-6080, DR-7580 and DR-9080c are high performance A3 scanners 
with a maximum scanning throughput of up to180 images per minute . They 
are double-sided scanners with automatic paper size and thickness 
detection. Additionally, document skew is automatically corrected during the 
document feed. 

The DR-6080 and DR-7580 support black & white and greyscale scanning 
whilst the DR-9080c supports several modes up to a maximum 24 bit colour. 
The maximum scanning resolution is for all scanners 600 dpi. 
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Scanner Configuration 
The following screen shows the first screen displayed when choosing 
Scanner Setup for the Canon DR-6080, DR-7580 or DR-9080C. 

 

Page Settings 
All three scanners are capable of scanning single or double sided 
documents, and different settings can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the option on the 
screen above can do this. 

The Fit Image option sets the scanner to automatically detect the size of 
each page scanned, and will adjust the page size to the actual size of the 
document. When this is set, the Page Size option is disabled  

If scanning double-sided documents, different settings can be applied for 
each side of the documents. To use the same settings for both sides of the 
documents, click on the Same settings for back side option. To use 
different settings for each side, uncheck the Same settings for back side 
option, and then choose from the drop down list which side you wish to 
choose to set the scanning preferences.  

For each side, or both sides of a document, the following options can be set. 
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Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm 
• B5 - 176 x 250 mm 
• B6 - 125 x 176 mm 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Mode This option is used to set the number of colours to be 
scanned. Please note that DR-6080 and DR-7580 support 
black & White and greyscale mode scanning. All other 
settings are applicable to the DR-9080c. The DR-9080c 
supports 24 bit colour scanning. The larger the bit value 
selected, the more colour shades will be scanned. Please 
be aware that greyscale and colour scanning, especially at 
high resolutions, can result in extremely large file sizes. 
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Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 
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Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

Double Feed Detection 

There are two methods to set the scanner to detect the simultaneous feeding 
of two or more sheets of paper. The scanner can be calibrated for paper 
thickness and/or length. To set Double Feed Detection tick either the 
Detect by ultrasonic or Detect by Length checkbox or both. When you next 
scan a batch of documents, the first page fed through the scanner will have 
its thickness and/or length measured and the measurement then stored. 
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Subsequent documents’ measurements will be compared against the stored 
value and if the scanned document is thicker or longer than the stored value, 
an error will be displayed. 

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Dropout Colour This function is only available with the DR-9080. It is 
available separately for the front and back page. It will 
disable the scanning of areas of the document of a 
particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

 

Other Options 

Other settings are available and these are detailed below: 

Option Description 

Verify Count This can be used to ensure that a known number of 
pages are being fed correctly through the scanner. 
Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 
through the scanner, an error will be displayed. 
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Simple Staple 
Detection 

The scanner has a simple staple detection for 
document feeding. When the sensor detects a staple 
in either upper corner, the scanning process is 
automatically stopped. 

Deskew by roll This function activates a hardware based deskew of 
sheets to ensure the correct feeding of pages. 

 

Imprinter Option 

If the Imprinter option has been installed in the scanner, this can be 
configured by selecting the Imprinter option from the Extended Settings 
screen. 

The Imprinter option allows you to print specified alphanumeric and symbol 
characters at any position on a back page as it is being scanned. You can 
also embed the characters to be printed in the scanned image. 

To set the Imprinter to print text on a page as it is being scanned, tick the 
Print checkbox. To embed the text as part of a scanned image, tick the 
Embed to image checkbox. 
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The text to be printed can be specified in the Text field. If the counters are to 
be used, these must be specified within square brackets. If both counters are 
used, the values must be separated by a decimal point (full stop). 

The Horizontal offset only applies if the text is to be embedded in the 
scanned image. You can specify the offset in millimetres from the left edge of 
the page. When printing text, the horizontal offset is applied manually, please 
refer to the scanner manual for instructions on how this is done. 

The Vertical offset specifies the distance in millimetres from the top edge of 
the paper to start printing the text. 

You can select to print the text on every page, on the first page of a new file 
as indicated by the New file key, by setting the Pages drop down list to 
Every or Next page. 

You can set the direction in which the text will print from the Orientation drop 
down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from right to 
left. 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x7 font size by ticking the Use small fonts checkbox. 

The Style of Embedment can be set from one of three options: 

• Black on White will print black text on to a white background. 
• White on Black will print white text on a black background. 
• Black on image will print black text on to the image. 
 
There are two counters that can be configured, and these options apply to 
both. The Start value of the counter can be set as well as the value to 
increment the value for each page.  

The following values can be set for the Reset if and Increment if options. 
Reset If will reset the counter to its start value. Increment If will add the 
specified increment value to the counter. 

• Never 
• Separator 
• New File or Separator 
• New File 
• Each Document 
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Canon DR-7080C 
The Canon DR-7080C can be used with a document feeder and a flatbed 
with documents up to A3. Therefore it is suitable to scan pages automatically 
from the document feeder and to scan single pages for example from books. 
In feeder mode the scanner can scan black and white, greyscale and full 
colour up to A3 size. The maximum resolution is 600 dpi. 

Scanner Configuration 
There are many options that can be selected for the scanners, and these are 
split over several option screens which are selected from Scanner Setup.  

The following screen is displayed when choosing Scanner Setup for the 
Canon DR-7080C. 

 

Page Settings 
The scanner is able to scan single or double sided documents, and different 
settings can be applied for each side of a double sided document. The first 
option to select is whether to scan single or double sided or to scan from 
flatbed without feeder. Selecting Front, Flatbed or Front/back scanning 
from the option on the screen above can do this. 

The Fit Image option sets the scanner to automatically detect the size of 
each page scanned, and will adjust the page size to the actual size of the 
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document. When this is set, the Page Size option is disabled if scanning 
double-sided documents, different settings can be applied for each side of 
the documents. To use the same settings for both sides of the documents, 
click on the Same settings for back side option. To use different settings for 
each side, uncheck the Same settings for back side option, and then 
choose from the drop down list which side you wish to choose to set the 
scanning preferences. 

For each side, or both sides of a document, the following options can be set: 

 

Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 In 
• Ledger-R -  17 x 11 In 
• Letter-R - 11 x 8,5 In 
• Legal-R – 14 x 8.5 In 
• A3-R - 420 x 297 mm 
• A4 - 210 x 297 mm 
• A4-R - 297 x 210 mm 
• A5 - 148 x 210 mm 
• A5-R - 210 x 148 mm 
• B4-R – 353 x 250 mm 
• B5 - 176 x 250 mm 
• B5-R - 250 x 176 mm 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 
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Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 
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Mode This option is used to set the number of colours to be 
scanned. 

Black & White: The black & white mode scans only in 
black & white. 

Greyscale: Greyscale mode creates images with 256 
greyscale levels. 

Colour: The DR-7080C supports 24 bit colour scanning. 
The larger the bit value selected, the more colour shades 
will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in extremely large 
file sizes. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. The DR-
7080c has an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. 
The DR-7080c has automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 
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When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Dropout Colour This function is available separately for the front and 
back page. It will disable the scanning of areas of the 
document of a particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis 

 

This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 
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Canon DR-5020, 5080C & 5060F 
The DR-5020, 5080c and 5060F are high performance A3 scanners with a 
maximum scanning throughput of 80 A4 pages per minute. They are all 
double-sided scanners with automatic paper size and thickness detection. 
Additionally, document skew is automatically corrected during the document 
feed process from the 500 sheet paper feed tray. 

The DR-5060F incorporates an inbuilt microfilm camera. 

The DR-5020 supports black & white scanning whilst the DR-5080c supports 
several modes up to a maximum 24 bit colour. The maximum scanning 
resolution for both of these scanners is 400dpi. The DR-5060F supports 
black & white scanning only with a maximum scanning resolution of 300dpi. 

Pre and post document endorsers are options which can be added to the 
scanners. A Barcode decoder can also be included as an option. 

Document specifications are: 

• Width 55mm to 297mm 
• Length 70mm to 432mm 
• Thickness 0.06mm to 0.15mm (0.05 to 0.2mm Manual Feed) 

Scanner Configuration 
There are many options that can be selected for the scanners, and these are 
split over several option screens which are selected from Scanner Setup. 
The most used options are collected together on the first screen displayed 
when Scanner Setup is selected. 

The following screen shows the first screen displayed when choosing 
Scanner Setup for the Canon DR-5060F. This has an additional option to 
the setup screen for the DR5020/80c, allowing the film position to be saved 
to a folder field, but apart from that the screen has the same options. 
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Page Settings 
All three scanners are capable of scanning single or double sided 
documents, and different settings can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the option on the 
screen above can do this. 

The Fit Image option sets the scanner to automatically detect the size of 
each page scanned, and will adjust the page size to the actual size of the 
document. When this is set, the Page Size option is disabled if scanning 
double-sided documents, different settings can be applied for each side of 
the documents. 

To use the same settings for both sides of the documents, click on the Same 
settings for back side option. To use different settings for each side, 
uncheck the Same settings for back side option, and then choose from the 
drop down list which side you wish to choose to set the scanning 
preferences. 

For each side, or both sides of a document, the following options can be set: 
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Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B4 – 257 x 364 mm (JIS) 
• B5 - 176 x 250 mm (ISO) 
• B5 - 182 x 257 mm (JIS) 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select up to one of the following resolutions : 200, 
210, 220, 230, 240, 250, 260, 270, 280, 290, 300 and 400 
dpi (Dots per Inch) 

With the above settings the horizontal scan resolution is 
the same as the vertical resolution. There are also 2 high 
speed scanning settings, which have split resolutions. The 
first figure is the horizontal setting, the second refers to the 
vertical setting. These are marked in the Resolution list 
with asterisks (*): 200 x100 and 300x150 dpi. 

Dither Use this setting when scanning in black and white mode.
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 
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Modus This option is used to set the number of colours to be 
scanned. 

Please note that the DR-5020 and DR-5060F only support 
Black & White mode scanning. All other settings are 
applicable to the DR-5080c. 

Black & White 

The black & white mode scans only in black & white. 

Greyscale 

The DR-5080c supports 4, 16 & 256 levels of Greyscale 

Colour 

The DR-5080c supports 3, 6, 12 and 24 bit colour 
scanning. The larger the bit value selected, the more 
colour shades will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in extremely large 
file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

 

Page 134 • Scanner Setup 



ScanFile SBE User Guide 
Canon DR-5020, 5080C & 5060F 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 
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The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

 
Double Feed Detection 

There are two methods to set the scanner to detect the simultaneous feeding 
of two or more sheets of paper. The scanner can be calibrated for paper 
thickness and/or length. To set Double Feed Detection, tick either the 
Thickness or Length checkboxes, or both. When you next scan a batch of 
documents, the first page fed through the scanner will have its thickness 
and/or length measured and the measurement then stored. Subsequent 
documents’ measurements will be compared against the stored value and if 
the scanned document is thicker or longer than the stored value, an error will 
be displayed. 

 
Manual Thickness Adjust 

The thickness setting can be manually adjusted when the automatic 
thickness detection is not used or when there are frequent double feeds of 
paper. 

The setting ranges from 1 to 13, with 1 being the thinnest, and 13 the thickest 
setting. To adjust this setting, tick the Activate checkbox, and then use the 
arrow keys at either end of the slider bar to increase or decrease the value. 

 
Border Removal 

You can set a margin around the scanning area. The value ranged from – 
10mm to +10mm. 

To use this function, tick the Activate checkbox. To adjust the values, use 
the arrow keys or the slider bar to increase or decrease the value. To enlarge 
the scanning area, to ensure the document edges are not clipped, set a plus 

Page 136 • Scanner Setup 



ScanFile SBE User Guide 
Canon DR-5020, 5080C & 5060F 

value. To reduce the scanning area, so that the image is not framed by a 
black border, set a minus value. 

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Erase Black Dots This will automatically erase isolated black dots on a 
white background from the scanned image. 

Erase White Dots This will automatically erase isolated white dots on a 
black background from the scanned image. 

Erase Notch This will automatically remove areas that are caused 
by contours 

Complete Thin Lines This will automatically fill in broken or thin faint lines. 

Drop Out Colour This function is only available for the DR-5080c and 
will disable the scanning of areas of the document of 
a particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 

 
Colour Dropout can be disabled for a part of the 
document by setting values in the Disable Dropout 
option. This is measured in millimetres, and is applied 
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is the 
value required. 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 13 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 
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Edge Emphasis This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

 

Other Options 

Several other settings options are available and these are detailed below: 

Option Description 

Verify Count This can be used to ensure that a known number of 
pages are being fed correctly through the scanner. 
Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 
through the scanner, an error will be displayed. 

Auto New File This setting can be used when batch scanning to 
automatically create a new file when the feeder 
empties. An option to continue scanning will be 
displayed and when this is pressed, a new file will be 
created. 

Use Front Panel When this is enabled, the front panel of the scanner 
can be used to override certain settings set in the 
scanner driver. In the case of the DR- 5060F the front 
panel enables the user to also control the microfilm 
scanning functions. 

 

DR-5060F Additions 

An additional feature of the Canon DR-5060F is the Save Film Position To 
option on the driver screen. This calculates the position of the film from the 
‘blips’ recorded on the microfilm by the built in camera unit on the scanner. 
When the position of the film has been calculated it can populate an index 
field in folders that have this option set. 
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Function Keys 

This settings screen can be used to set the functions available on the four 
keys on the front panel of the DR-5020, DR-5060F and DR-5080c. The 
available functions are: 

• Manual Thickness Adjustment 
• Scanner Calibration 
• Auto Thickness Detection On/Off 
• Auto Double Feed Detection On/Off 
• Imprinter On/Off 
• Save Settings 
 

Gamma 

This option is used to download to the scanner Gamma data settings used to 
express colours and tones. These can be set for each of the colours shown. 

To select a file, choose the colour from the dropdown list and then press 
Open File. This will allow you to select the Gamma settings file to associate 
with that colour. 

 
Barcode Decoder 

If the Barcode decoder option has been installed in the DR-5020, DR-5080c 
or DR-5060F, the Barcode Setup option will be available from the Extended 
Settings screen. From this screen you can set which barcode types are to be 
searched for, and you can also specify an area of the document to search for 
barcodes, which can be on the front or back of a scanned page. 

The scanners will recognise the following barcode types: 

• EAN 
• Code 39  
• Codabar 
• Code 25  
• UPC 
• UPC-A 
• UPC-E 
• Code 128 
 

Up to four barcodes of differing types can be searched for and read from a 
document. The number to read can be set in the Barcodes per page option. 
To select the side of the page that the barcodes are on, choose the 
appropriate option from the Side drop down list. 
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To activate the barcode recognition, tick the Use barcode recognition 
checkbox. The Activate buzzer option will set the scanner to buzz each time 
a barcode is found and read. 

Additionally you can set a specific an area on a page to search for barcodes. 
To select this option tick the Activate checkbox under Search Area.  

The area to be read must be specified in millimetres, and the top left of the 
search area is set by putting the appropriate values in the Horizontal and 
Vertical offset value fields. You can then specify the width and height of the 
search area in the Width and Height value fields. 

To set the scanner to read a particular barcode format or formats, tick the 
Activate checkbox in each of the barcode formats. 

Barcode Option 

EAN To read the Extended EAN format, tick the Extended
checkbox. 

Code 39 If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. You can also select to 
include the start and stop characters in the barcode read 
by ticking the Return start/stop checkbox. 

Codabar If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. There are two checksum 
options for Codabar, Mod 16 and DR7, which can be 
selected from the drop down list. You can also select to 
include the start and stop characters in the barcode read 
by ticking the Return start/stop checkbox. 

Code 25 If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. 

By selecting UPC, you can then also select UPC-A and/or 
UPC-E. 
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UPC-A Extended UPC-A can be read by ticking the Extended
checkbox. 

If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. The header 
can also be returned by selecting the Return Header
checkbox. 

UPC-E If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. The header 
can also be returned by selecting the Return Header
checkbox. 

Code 128 Code 128 has no options.  

 

Imprinter Option 

If the Imprinter option has been installed in the DR-5020, DR-5080c or DR-
5060F, this can be configured by selecting the Imprinter option from the 
Extended Settings screen. 

The Imprinter option allows you to print specified alphanumeric and symbol 
characters at any position on a page as it is being scanned. You can also 
embed the characters to be printed in the scanned image. 

To set the Imprinter to print text on a page as it is being scanned, tick the 
Print checkbox. To embed the text as part of a scanned image, tick the 
Embed to image checkbox. 
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The text to be printed can be specified in the Text field. If the counters are to 
be used, these must be specified within square brackets. If both counters are 
used, the values must be separated by a decimal point (full stop). 

The Horizontal offset only applies if the text is to be embedded in the 
scanned image. You can specify the offset in millimetres from the left edge of 
the page. When printing text, the horizontal offset is applied manually, please 
refer to the scanner manual for instructions on how this is done. 

The Vertical offset specifies the distance in millimetres from the top edge of 
the paper to start printing the text. 

You can select to print the text on every page, on the first page of a new file 
as indicated by the New file key, by setting the Pages drop down list to 
Every or Next page. 

You can set the direction in which the text will print from the Orientation drop 
down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from right to 
left. 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x7 font size by ticking the Use small fonts checkbox. 
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The Style of Embedment can be set from one of three options: 

• Black on White will print black text on to a white background. 
• White on Black will print white text on a black background. 
• Black on image will print black text on to the image. 
 
There are two counters that can be configured, and these options apply to 
both. The Start value of the counter can be set as well as the value to 
increment the value for each page.  

The following values can be set for the Reset if and Increment if options. 
Reset If will reset the counter to its start value. Increment If will add the 
specified increment value to the counter. 

• Never 
• Separator 
• New File or Separator 
• New File 
• Each Document 
 

Options Screen 

The Options screen is for information and will show the attached scanner's 
installed or available options. 

The Barcode, Imprinter and Endorser checkboxes will be ticked if the options 
are installed. 

Option Description 

CC CC is a special filter option 

YG-LED Will be ticked if the attached scanner is a DR-5020 
or DR-5060F 

Red/Green/Blue-LED Will be ticked if the DR-5080c is attached 

 

The View options are values returned by the scanner. The DR-5080c will tick 
all three checkboxes. The DR-5020 and DR-5060F will return only Black & 
White and Bi-tonal. 
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Canon DR-3060, 3080C & 3080CII 
The DR-3060, DR-3080c and DR-3080cII  are high performance A4 scanners 
with a maximum scanning throughput of 40 pages per minute. They are all 
double-sided scanners with automatic paper size and thickness detection. 
Both scanners incorporate a 100 sheet paper tray. 

The DR-3060 supports black & white and 256 level greyscale scanning whilst 
the DR-3080c supports several modes up to a maximum 24 bit colour. The 
maximum scanning resolution for both scanners is 300dpi. 

Post document endorsers are options which can be added to the scanners. 

Document specifications are: 

• Width 55mm to 257mm 
• Length 70mm to 364mm 
• Thickness 0.06mm to 0.15mm (0.05 to 0.2mm Manual Feed) 

Scanner Configuration 
There are many options that can be selected for the scanners, and these are 
split over different option screens which are selected from Scanner Setup. 
The most used options are collected together on the first screen displayed 
when Scanner Setup is selected. 

The following screen shows the first screen displayed when choosing 
Scanner Setup for the Canon DR-3060, DR-3080C or DR-3080CII. 
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Page Settings 
All three scanners are capable of scanning single or double sided 
documents, and different settings can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the option on the 
screen above can do this. 

Please note that greyscale and colour scanning is only available for single 
sided, front page scanning on DR-3060 and DR-3080C. 

The Adjust option sets the scanner to automatically detect the size of each 
page scanned, and will adjust the page size to the actual size of the 
document. 

For each side, or both sides of a document, the following options can be set: 
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Option Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B5 - 176 x 250 mm (ISO) 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select up to one of the following resolutions  

• 200 dpi 
• 240 dpi 
• 300 dpi (Dots per Inch) 

 
With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 

There is also a high speed scanning setting, which has a 
split resolution. The first figure is the horizontal setting, the 
second refers to the vertical setting: 300x150 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 
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Modus This option is used to set the number of colours to be 
scanned. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

The DR-3060 and DR-3080c support 256 levels of 
Greyscale 

Colour 

Only the DR-3080c supports 3, 6, 12 and 24 bit colour 
scanning. The larger the bit value selected, the more 
colour shades will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in large file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
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original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Skew Correction 
This function is a software driver based skew correction facility that can be 
selected by a checkbox on the main Scanner Setup window. Should pages 
be scanned at an angle through the scanner, and not appear straight when 
viewing, this option will straighten the page and justify it which will help when 
performing other actions such as OCR. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 
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When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

Option Description 

Automatic Page 
Suppression 

This function allows both scanners to ignore 
unwanted blank pages being scanned. This can be 
performed for the front and back of a scanned page. 
To switch this option on click on the relevant activate 
checkboxes. The levels at which a blank page can be 
identified can be adjusted by the blackness threshold 
slide bar, this will help to identify pages with little 
surface coverage on the page and depending on the 
levels set will ignore those pages. 

Drop Out Colour This function is only available for the DR-3080c and 
will disable the scanning of areas of the document of 
a particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 

 
Colour Dropout can be disabled for a part of the 
document by setting values in the Disable Dropout 
option. This is measured in millimetres, and is applied 
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is the 
value required. 
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Edge Emphasis This can be used to emphasise contour lettering, as 
well as softening scanned images such as photos. 
This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Canon DR-2050C & DR-2080C 
The DR-2050C and the DR-2080C are compact A4 workgroup scanner with 
a maximum scanning throughput of 20 pages per minute, or 39 images per 
minute when scanning double sided documents. They support black & white 
and 256 level greyscale scanning, and 24 bit colour. The maximum scanning 
resolution is 600dpi. 

The following picture shows the DR-2050C and DR-2080C Scanner setup 
screen. 

 

Setting Description 

Page Size The ScanFile SBE driver will automatically detect the size 
of the page being scanned if the Adjust option is selected. 
If it is not selected, the maximum scan size will be used, 
and the image may have a black border. 
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Resolution The DR-2080C supports resolutions from 100dpi to 
600dpi. The resolutions available will be dependent upon 
the scanning mode selected. 

• Black & White/Greyscale 200-600dpi 
• 24bit Colour 100-400dpi single/double sided 
• 600dpi single sided 
 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 
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Mode This option is used to set the number of colours to be 
scanned. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

Both scanners support 256 levels of Greyscale 

Colour 

Both scanner support 24 bit colour scanning. The larger 
the bit value selected, the more colour shades will be 
scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in very large file 
sizes. 

Pages You can select whether to scan single or double sided 
documents. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. Both scanners 
have an automatic brightness function built-in, but this can be overridden and 
manually set if necessary. 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 
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Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. 
Both scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Canon DR-3020 
The Canon DR-3020 is a 40 page per minute black & white scanner with 
automatic paper thickness and size detection, with a maximum paper size of 
B4. Its automatic document feeder can take up to 100 sheets at a time, and 
these can be either single or double-sided documents. It has an industry 
standard SCSI-2 interface. The DR-3020 has a maximum resolution of 
300dpi. 

To configure the DR-3020 scanning options, ensure that the DR-3020 is set 
as the default scanner and then click on the Scanner Setup button. The 
following window will then be displayed 
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Scan Resolution 
The Canon DR-3020 has three scan resolutions 

• 200x200dpi 
• 300x300dpi 
• 300x150dpi 
 

The selected scan resolution will affect the quality of the image, and also the 
scan speed. At a resolution of 300 x 150dpi, scanning single sided 
documents, the DR-3020 will scan at 40 pages per minute. At 300 x300dpi, 
scanning double-sided documents will slow the scanner to 11 sheets per 
minute. 

Page Size 
The DR-3020 can scan up to A4 size pages. The paper size can be selected 
from the drop down list. By selecting Maximum, and clicking on the Adjust 
option, the DR-3020 will auto detect the paper size. 
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View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Text Mode. Photo Mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo mode option will result in 
larger scanned file sizes. 

Documents, by default, are displayed using black text on a white background. 
The Inverted option allows this to be reversed, so that the document is 
displayed with white text on a black background. 

The DR-3020 scans documents in 'portrait' format. For landscape 
documents, select the Rotate 90° option so that they will be displayed in the 
correct orientation. 

When selected, the Front/Back scanning option will scan and store both 
sides of the scanned document. When not selected, only the front side of the 
document is scanned. 

Brightness Controls 
The Canon DR-3020 has an automatic brightness function, which should 
work with most documents. Unticking the Auto option, and then selecting the 
required brightness setting by using the slider bar, or by typing in the 
brightness value, between 1-255, can override this. 

Check Scanner 
ScanFile SBE support several check scanners, which can read MICR Coded 
checks. The following check scanners are supported: 

• • TellerScan TS200 
• • TellerScan TS300/350 
• • TellerScan TS400ES 
• • BUIC 1500 
 
Some of the described settings may only apply to certain scanner models. 

Resolution 
The resolution can be 200x100 dpi or 200x200 dpi. Using 200x100 dpi 
scanning speed is bigger, but quality is less. The minor quality image is 
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interpolated to a 200x200 dpi image. Select the resolution which serves your 
application best. 

MICR 
The MICR code can be read and stored to index fields of ScanFile SBE 
folders. Select the relevant MICR type between CMC7 and E13B. 

In order to store the MICR information to ScanFile SBE index fields you have 
to perform a test scan first. Afterwards the check will be displayed in the test 
scan display window and the adjoining MICR information will be displayed in 
the text fields below. For each of the different MICR information parts, you 
can select a ScanFile SBE index field from a drop down list. When scanning 
checks, the relevant information will then be stored automatically in these 
fields. 

Axis 7000 
The Axis 7000 is a network scan server box that will allow across network 
scanning with any scanner that is attached and supported by it. 

Scanner Configuration 
There are many options that can be selected for any scanners attached to 
the Axis 7000, and these are defined in the Scanner Setup. The most used 
options are collected together on the first screen displayed when Scanner 
Setup is selected. 

The following screen dialogue shows the first screen displayed when 
choosing Scanner Setup for the Axis 7000. 
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Please note that any settings that are defined for the Axis 7000 are 
dependant on the scanner that is attached to it. It is not possible to define 
which scanner is attached to it so the Axis 7000 must only be setup with the 
settings that are specific to that scanner.  

Scanner SCSI ID 
To be able to recognise the Axis 7000 Scan Server you must enter its IP 
Address and the User Name and Password that have previously been 
configured on the Axis 7000. The correct configuration of the Axis 7000 can 
be verified using your web browser, please refer to the Axis user manual for 
details on how to do this. 

Page Settings 
Any scanners attached that are capable of scanning single or double sided 
documents can have different settings applied for each side of a double sided 
document. The first option to select is whether to scan single or double sided, 
by selecting Front or Front/back scanning from the Pages drop down. 

The Adjust option sets the scanner to automatically detect the size of each 
page scanned, and will adjust the page size to the actual size of the 
document. 
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For each side, or both sides of a document, the following options can be set: 

Setting Description 

Page Size You can select any Page Size that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which Page Sizes are available for 
each scanner. 

Resolution You can select any Resolution that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which resolutions are available for 
each scanner. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and halftones 
on the scanned document. This is useful when scanning 
photos.  

The Inverted option allows you to change from black on a 
white background, to white on a black background. 

Mode This option is used to set the number of colours to be 
scanned. You can select any colour mode that is 
supported by the scanner attached, please check the 
relevant sections of this manual to verify which colour 
modes are available for each scanner.  

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in large file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are Portrait and Landscape 

Page 158 • Scanner Setup 



ScanFile SBE User Guide 
Axis 7000 

Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Skew Correction 
This function is a software driver based skew correction facility that can be 
selected by a checkbox on the main scanner setup window. Should pages be 
scanned at an angle through the scanner, and not appear straight when 
viewing, this option will straighten the page and justify it which will help when 
performing other actions such as OCR. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
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dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Canon MS-300, 350 & 800 
The Canon MS300, 350 and 800 microfilm scanners offers high speed and 
high resolution scanning and provide easy conversion and integration into 
existing digital environments. Full automatic search and retrieval/scanning 
functions are available via the optional FS Controller III, where the scanner 
supports it. 

Scanner Configuration 
The following screen shows the main settings screen displayed when 
choosing Scanner Setup for the MS-300, MS-350 or MS-800: 

 

Page Settings 
A number of options can be set which will affect the size, quality and 
orientation of the documents being scanned. These are in the View section 
on the Scanner Setup screen.  

The tables below and on the following pages show the available settings. 
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Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B4 - 257 x 364 mm (JIS) 
• B5 - 176 x 250 mm (ISO) 
• B5 - 182 x 257 mm (JIS) 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following resolutions 200, 300, 
400 and 600 dpi (Dots per Inch) 

With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 
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Mode The scanners support black & white and greyscale 
scanning 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

The scanners support 4, 16 & 256 levels of 

Greyscale 

Please be aware that greyscale scanning, especially at 
high resolutions, can result in extremely large file sizes. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 
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Compression ScanFile SBE will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile SBE has various quality levels 
for Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 
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When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Feeder Selection 
The microfilm scanners MS300/350/800 can use the Canon FS Controller III 
for automatic film advancement while scanning. Additionally, an automatic 
fiche carrier is available in some countries. 

Scan Area Setting 
The MS300 and 350 have an A4 Portrait screen and the MS800 an A3 
Landscape screen. On the MS800, the screen can also be separated into two 
A4 portrait zones or a centred A4 portrait zone. This setting will affect how 
the documents being displayed are scanned. There are four settings as 
follows: 

Setting Description 

Left This will scan the left A4 portrait zone 

Centred Scans the Centred A4 zone 

Separated Scans the left and right A4 portrait zones, and stores the two 
pages separately.
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pages separately. 

Overlaid This mode can scan two A4 portrait halves and combines 
them in to one A4 portrait. Each half on the A4 Portrait is 
centred within the left and right A4 portrait zones. The scan 
from the right zone will be the top half of the page and the 
bottom half will be from the left zone. 

Extended Settings 
This option can be used to set whether to use the front panel of the scanner 
to control scanning, rather than ScanFile SBE itself. E.g. if you selected the 
option, you have to start the scan process by pressing the green button on 
the front panel of the MS-800. 

FS Controller III 
This section describes the setup and initialisation of the scanner with the FS 
Carrier III. A full description of this will be available in the FS Carrier III 
manual. 

Blip Level Description 

1 Pageblip 

2 File – Pageblip 

3 Batch - File- Pageblip 

 

 1 Blip 2 Blip 3 Blip  

Shift + F +  Store    Return 

Password    149 149 149 Return 

1 Search Mode    Return 

Mode # 5 2 3 Return 

Canon Meth No No No Return 

Ser Progr. 8 13 13 Return 

Std Blip Yes Yes Yes Return 
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Neg. Blip Yes Yes Yes Return 

N/P Key on No No No Return 

Stand Slice Yes Yes Yes Return 

Count Splice No No No Return 

(Set)=#1 DOC Yes Yes Yes Return 

Enable (Auto) No No No Return 

Indexing --- No No Return 

Send Address No No No Return 

Input OK Yes Yes Yes Return 

8 X   Plus Key     

Exit    Return 

 

Mode Setting  

Film adjust vertical SHIFT +  or  Return 

Film adjust horizontal SHIFT + 4 then Yes or No Return 
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FS Controller III – Scanning with Batch- + File 
    

Shift + F  + Store   Return 

Password 149  Return 

1 Search Mode   Plus Key 

2 Machine setup   Return 

Trailer stop No  Return 

Mod F&C nstd No  Return 

E/M detect Yes  Return 

Key buffer No  Return 

Face U/D set No  Return 

Face down Yes Scan in ascending order Return 

Face down No Scan in descending order Return 

Adrs prt set No  Return 

Address prt No  Return 

Japanese MSG No  Return 

Input OK Yes  Return 

7 X Plus Key    

Exit   Return 

Canon MS400 & 500 
Canon’s digital microfilm reader printers have an optional SCSI kit to enable 
them to be used as PC scanning devices. Two modes are supported – 
manual or automatic feed scanning. With automatic feed scanning, an FS 
Carrier III will be required, as well as blipped films. 

The maximum resolution of the MS scanners is 400dpi. 
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Scan Resolution 
The MS400 & 500 have three scan resolutions 

• 200x200dpi 
• 300x300dpi 
• 400x400dpi 

View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Text Mode. Photo Mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo Mode option will result 
in larger scanned file sizes. 

Documents, by default, are displayed using black text on a white background. 
The Inverted option allows this to be reversed, so that the document is 
displayed with white text on a black background. 

The scanned documents can be rotated 90 degrees clockwise by selecting 
the Rotate 90° option so that they will be displayed in their correct 
orientation. 
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Film Type 
Use this option to set the type of film loaded into the microfilm scanner. The 
Auto option will automatically detect the type of film loaded. 

Feeder 
This option allows you to set the type of feeder used on the microfilm 
scanner. It can be set for the Canon FS Carrier III, or Auto Fiche Carrier. For 
the Auto Fiche Carrier, the Communication port and baud rate being used 
must also be set. 

Please note that these feeder options may not be available in all countries. 
Please check with the supplier of the microfilm scanner for availability. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

FS Controller III 
This section describes the setup and initialisation of the MS400/500 with the 
FS Carrier III. A full description of this will be available in the FS Carrier III 
manual. 

Mode Description 

I Page 

II File - Page 

III Batch – File - Page 

VII File – Page 

 

 Mode I Mode II Mode III Mode VII  

Shift + F +  Store     Return 

Password    149 149 149 149 Return 
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1 Search Mode     Return 

Mode # 1 2 3 7 Return 

Canon Meth Yes No No No Return 

Serge Progr. 31 13 13 10 Return 

Ser. Level 1 --- --- --- Return 

Std Blip Yes Yes Yes Yes Return 

Neg. Blip Yes Yes Yes Yes Return 

N/P Key on No No No No Return 

Stand Slice Yes Yes Yes Yes Return 

Count Splice No No No No Return 

(Set)=#1 DOC Yes Yes Yes Yes Return 

Enable (Auto) Yes No No No Return 

Indexing --- No No No Return 

Send Address No No No No Return 

Input OK Yes Yes Yes Yes Return 

8 X   Plus  Key      

Exit     Return 

 

SW103 – with FS Controller III 

1 2 3 4 5 6 7 8  

x x x • x x x x On 

• • • x • • • • Off 
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SW103 – Without FilePrint 300 

1 2 3 4 5 6 7 8  

• x x x x x x x On 

x • • • • • • • Off 

 

Mode Description 

Film adjust vertical SHIFT +  or  then + or - 

Film adjust horizontal SHIFT + 4 then Yes or No then Return 

Canon Canofile 510/510S 
The Canofile 510 is a standalone electronic filing system with a built-in 50 
page per minute double-sided scanner. This has been discontinued by 
Canon. However, the CF510 has a SCSI connection which enables it to be 
attached to a PC and used as a scanner. Only certain CF510s can be used 
as scanners, so please check with Canon to ensure compatibility. 

The screen below shows the scanner setup for the Canofile CF510 and 
Canofile CF510S. 
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Scan Resolution 
The CF510 has two scan resolutions 

• 200 x 100 dpi 
• 200 x 200 dpi 

View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Standard Mode. Photo mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo Mode option will result 
in larger scanned file sizes. 

Each document scanned by the CF510 will have a Black border up to the 
maximum paper size of the CF510 scanner. Choosing the Crop Border 
option removes this border. 

The CF510 has a double-sided scanner, this can be set to scan the front of a 
document only or both sides of a document. For double-sided scanning there 
are two options. Front/Back scanning will place each side of the document 
into a separate page. Choosing Front/Back One Page will result in both 
sides of the document being stored as one image. 
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Brightness Controls 
The scan brightness settings can be adjusted manually to suit the documents 
being scanned. Alternatively, the Auto option can be used to allow the 
scanner itself to determine the optimum setting. 

TWAIN 
ScanFile SBE has support for TWAIN compliant devices. TWAIN is an open 
standard device driver for scanners, and any scanner supplied with a TWAIN 
device driver should work with software applications supporting the TWAIN 
standard. 

The scanner settings for TWAIN devices are set directly within the TWAIN 
device driver itself. The TWAIN interface will be displayed when scanning is 
started from ScanFile SBE, whereupon the scanner settings can be applied. 

When selecting Scanner Setup from the Options menu, the TWAIN setup 
screen will be displayed. From this screen you can select whether the TWAIN 
device driver interface will be displayed, and therefore whether you can 
change the current settings. If you choose not to display the screen the 
scanner will immediately start scanning. 

If the scanner is a double-sided device, choosing the Use duplex mode will 
set the scanner to double sided scanning. 

Some TWAIN scanners have built-in image compression capabilities to 
reduce the amount of information sent between the scanner and the PC. If 
the scanner has this capability, it can be selected by choosing the Use 
Compressed Transmission option. 

Kofax 
Kofax manufacture specialist image processing boards for PCs to allow them 
to support high-speed scanners from companies such as Bell & Howell and 
Kodak. A TWAIN driver is available for the KOFAX scanner. 
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Maintenance 
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Overview 
Built in to ScanFile SBE are utilities that will assist you if you experience 
problems with any of your folders or libraries. For this case ScanFile SBE 
offers following functions to maintain and repair folder and libraries.  

The functions do not replace a regular backup. You should always take 
regular backups of all your ScanFile SBE folders and libraries to prevent 
loss of data. 

Maintain Folder 
This utility is available from File -> Maintain Folder. ScanFile SBE will check 
a folder for any errors within the database and for missing or corrupt 
document files. If any incorrect index records or records pointing to missing 
document files are found, a record of these will be written to the file 
Error.log, which is created in the PC’s TEMP directory. 

Problems such as these can occur if the PC was switched off during 
scanning or deleting, if the hard disk became full or corrupt, or if document 
files have been deleted from the ScanFile SBE folder from outside of 
ScanFile SBE. 

Unfortunately, there is not a way to automatically correct such problems, and 
therefore the concerned index records will have to be deleted, and the 
documents rescanned. 

The Maintain folder utility may take some time to run but it is strongly 
recommended before writing a folder to archive write-once devices. 

Repair Folder 
If you experience a problem when trying to open a folder, you will be 
prompted to run the Repair folder utility. You can select this option from the 
File -> Repair Folder menu. This will attempt to repair and compact the 
folder database. Over time, the database may become fragmented on the 
hard disk, which will affect its performance. Compacting the database will 
rewrite it to a single area of the hard disk, and will also free any unused 
space in the database caused by deleted records. In most cases, running this 
utility should resolve problems with the folder. 
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